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Preface 
 

Who is this Guide aimed at? 
 

This manual introduces you to the HP Indigo Labels and Packaging solution powered by 
EskoArtwork 

You will find all the necessary information you need to make you feel at ease working with the 
software. It is meant to be equally helpful to first time users and skilled operators who might 
need a little extra assistance from time to time. 

 

What does this Manual contain? 
This Manual basically consists of the following parts: 

1. Installation 
2. FlexRip 
3. WorkFlow Manager & WorkFlow Manager Pilot 
4. Variable Data Printing 
5. Illustrator PlugIns 

• BarX 
• StepX 

6. BackUp & Restore 
7. Appendix: HP Indigo Labels and Packaging Color Kit powered by EskoArtwork 
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Introduction 
 

FlexRip to HP Indigo is the software required to interface from an Esko system to an HP 
Indigo Digital Press.  

• The output of the FlexRip is written into a JLYT file. 
• The Job Layout (JLYT) language is the HP Indigo Digital Press internal language used to 

define job structure, document layout and essential job ticket information.  
• The FlexRip writes the JLYT file on a hotfolder of the HP Indigo system.  
• The job will appear in the HP Indigo system•s interface and can be further processed 

over there. 
 

The following diagram illustrates this workflow. 

 

1.tif 
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General workflow 
 

The following lists enumerate the basic steps that are needed to submit a job to the HP Indigo 
digital Press. Each of these steps will be described further on in more detail. 

 

Basic steps 
 

The basic steps to submit a job to the HP Indigo Digital Press are the following: 

 

1. In the FlexRip Configurator application , create a configuration for the HP Digital color 
press. 

2. In HP Indigo Labels and Packaging Color Kit powered by EskoArtwork, create a Color 
Strategy using the output colorspace of the press i.e. Indichrome, Indichrome + extra 
inks, CMYK, CMYK + extra inks). 

3. In the Dispatcher, define the Queue Settings of the Server queue: enter none” as 
Configuration and Output location. 

4. In the WorkFlow Manager Pilot, create a ticket that uses the above defined Color 
Strategy and configuration. 

5. Submit the job from WorkFlow Manager Pilot, using the above ticket. 
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Installation 

Note: Please check the specific Installation Manual (Installation 
documentation procedure): this document describes in detail how to 
proceed with the installation of Esko Software Suite 7 on a new 
server. 

 

The installation of Esko SoftWare Suite 7 consists of following steps: 

 

Setting up Windows 

Follow HP procedure to install the Windows Server operating system. Make sure, that 
services for Macintosh are enabled and computer name of the server is set according to 
customer request. The server must be restarted after change of the computer name. 
 

Installation of Esko Software Suite 7 

Before proceeding with the initial installation of Esko Software Suite 7, make sure that you 
have a hardware dongle with corresponding license file available. 
See the Installation Manual for a step by step guide. 
 

Adapting configurations to the new server name 

Configurations provided by Esko must be adapted to the name of a new server. This change 
should be performed on a different PC with Java runtime installed and network access to the 
new server. 

• FlexRip HP Indigo configuration 
It is mandatory to know the computer name of the HP Indigo press before proceeding 
with this procedure. 

• WorkFlow Manager configuration 
The new server must be running duringthe configuration actions. 

 

Configuration of Esko Software Suite 7 

All steps have to be performed on the new server. Make sure, that you have available 
adapted configs for your server before proceeding further. 
See the Installation Manual for a step by step guide. 

• Prepare folder structure for hotfolders 
• Applying default setup to the Dispatcher 
• Starting up the Dispatcher 
• Connecting Dispatcher with WorkFlow Manager Server 
• Containers 
• Applying default setup to the WorkFlow Manager server 
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The FlexRip 
 

Startup and shutdown of the FlexRip/HP Indigo -
Why and when? 
In any normal FlexRip workflow, the FlexRip computer should never be shut down. Even 
reconfiguring RIP queues does not require shutting down or rebooting the computer. 

 

So why shut down the FlexRip? 

• You expect a power failure. 
• You physically want to move the computer. 
• You have to open the computer (hardware service reasons). 

 

Or why reboot the FlexRip? 

• The Windows software asks you to. This will often be the case when re‐installing 
Windows software or peripherals on the computer. 

• Some (Esko) service intervention requires to do so (changes to configuration of the 
network, modem or display might require a reboot afterwards). 

 

A Windows shutdown will automatically stop all running processes. This means that also all 
running Esko programs will be stopped automatically. We do advise you to separately stop all 
programs before rebooting or shutting down the FlexRip computer. 

As the FlexRip is made to rip, and the RIP itself is a client process of the Dispatcher program, 
the most important program running on your FlexRip is the Dispatcher!  
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How to start up a FlexRip? 
 

Start up the computer 
The FlexRip computer is switched off. 

• Check the network cable. 
• Switch the monitor on. 
• Remove all floppy disks or CDs from their drives. 
• Press the power button (top‐left on front panel). 

Windows will make your computer boot automatically. If you are not familiar with PC 
operating systems, never intervene during the boot process. The boot sequence should end 
with a screen that has the window: 

”Begin logon” 
•Press Ctrl + Alt + Delete to log on• 
 

If you wish to use the normal FlexRip software, log on as user ‘FlexRip’ with password 
•flexrip•. 

Only log on as user ‘Administrator’ for Windows system‐management reasons or to install 
software. 

 

Starting up the Rip 
Starting the Dispatcher program starts the RIP. 

• Start up the •Dispatcher” by double‐clicking its desktop icon or by choosing the right 
Dispatcher via Start\Programs\Esko\FlexRipT4 7.0 

• Start up the •Status Monitor• in the Tools menu in (each) Dispatcher. 
• Start up the •History View• in the Tools menu in (each) Dispatcher. 

 

Note 
Renaming the desktop icon can only be done in the FlexRip Configurator. 
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How to shut down a FlexRip? 
 

Stopping the Rip 
Closing the Dispatcher program stops the RIP. 
 

Note 
When stopping the Dispatcher program, it is always advisable to close its client programs 
Status Monitor and History View first. 
 
How to stop the Dispatcher: 

• Choose Exit from the Server menu and confirm by clicking Yes on •Are you sure? 
• Or simply click the close button (top‐right in the Dispatcher window) and confirm 

with Yes on •Are you sure? •. 
 

Warning 
When the Dispatcher program is stopped, all ripping processes stop executing and the RIP 
itself is stopped. 
 

When an ongoing RIP process has to be stopped for some reason, then choose •Abort job• 
from the Server menu. This stops all ongoing RIP processes, but leaves the Dispatcher 
program alive. As soon as you send a new job to the RIP, the RIP will start up automatically. 

 

Shutting down the computer 
To shutdown the FlexRip computer: 

1. Close all programs. 
2. Start\Shut Down. Choose •Shut down the computer• and click YES. 
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How to reboot the FlexRip computer? 
 

• Close all programs. 
• Go to Start\Shut Down\Restart the computer and click YES.  

The computer will automatically shut down and restart again. 
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An overview of the programs on the 
FlexRip 
 

General 
 

Logged on as user ‘FlexRip’, you will  find some shortcuts on your desktop that start up the 
specific Esko applications, the number depends on the installed licenses. 

If you do not find any desktop icons go via Start\Programs\Esko... 

 

On the Server: 

 

1. The FlexRipHPIndigo 7.0 Dispatcher is the •heart• of the FlexRip. It is both 
the ‘daemon’ (continuous automatic process) that makes the RIP run and the 
place where all queues and RIP options are set up. 
Each output device requires a new Dispatcher. This means that if you make 
files for 3 different output devices, you will have 3 Dispatchers. 
Note 
Note that each Dispatcher needs a separate licence. 

2. The FlexRipConfigurator allows you to add, modify or delete configurations. 
Note 
You should be logged on as •Administrator• to be able to use the FlexRip 
Configurator. 

3. WorkFlow Manager Pilot 
4. Intellicurve 
5. FontManager 7.0 
6. HP Indigo Labels and Packaging Color Kit powered by EskoArtwork 

Import ICC Profiles 
 

On the client: 

 

1. WorkFlow Manager Pilot 
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Which logon to use? 
 

• When do you log on as user Administrator? 
When you are installing or removing software or configuring your FlexRip computer 
on Windows level (networking, connectivity etc). 

• When do you log on as user FlexRip? 
In all other cases. All daily use of your FlexRip: the Dispatcher or its queue 
management, IntelliCurve, Bitmap Viewer. 
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FlexRip Configurator setup 
 

Via FlexRip Configurator we create a configuration that describes the output device, 
in this case the HP Indigo Digital Press. 

 

Mapping HotFolders of the HP Indigo Press 
 

(in this example the name of the Press PC is \\indigo) 

 

The output folder of the RIP is the hotfolder on the HP PC. Please note, that all of the paths 
must use the UNC format, with the 'Images on Press' field being the only exception, since this 
path is used by the press to access – in a Variable Data Workflow -  the variable JLT files 
stored at its local drive.  

 

Typical paths look similar to this: 

Output: \\indigo\jobs\press\input\lan 

Images on Rip: \\indigo\jobs\press\images 

Images on Press: S:\jobs\press\images 

 

On the HP PC: 
• The HP PC has a partition mapped on drive letter “S:” 
• Drive S: \jobs is exported on the network as a Windows share. 

 

On the FlexRip PC: 
• The Hotfolder is accessed as \\indigo\jobs\press\input\lan 

 

The WorkFlow Manager user BGSYSTEM must have write access to the hotfolder of the 
press PC. If not, the 'RIP to WS4000 Series' task will cause an  error when writing the Master 
JLT to the hotfolder. 

 

By convention the Hotfolder is located on the S: drive. However there is no technical 
restriction towards the drive letter used. 

 

In case there is more than one HP Indigo press in the network you should use 
several drive letters, one for each HP Indigo press. 

 

Warning 
When submitting a job to the RIP, the HP front end at the press side has to be up and 
running. Otherwise the job will not show up in the HP interface. 
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First check whether this is the case, e.g. using the Windows Explorer.  

If it is not, you first have to create this setup correctly before you continue setting up 
the FlexRip configuration. 

 

 

 

 

 
 
 
 
 
 

Setting up an FlexRip configuration 
 

The FlexRipConfigurator application is a common configuration application for all FlexRip 
flavours. With this application the configuration settings of all the installed FlexRip flavours on 
a particular system can be set up or checked. 

 

  

2.tif 

 

Create a new Configuration 
 

1. Close the FlexRip/HP Indigo Dispatcher if it is running and start the 
FlexRipConfigurator application. 
 
Perform the following steps to start up the FlexRipConfigurator application: 

• Log in as user Administrator or any other user with administrative privileges. 

Drive S: 

FlexRip/Indigo PC Indigo 
HotFolder 

Input:   
S:\jobs\press\input\lan 

Images: 
S:\jobs\press\images 

Output:  
\\indigo\jobs\press\input\lan 

Images:  
\\indigo\jobs\press\images 
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• Double-click the FlexRipConfigurator 7.0 icon on the desktop or click [Start] 
in the bottom task bar, select Programs\ or All Programs\ (depending on the 
operating system version) Esko\FlexRipConfig7.0 

• A splash screen will be displayed followed by the main 'FlexRip Configurator' 
window. At startup time only the buttons New, Backup and Exit will beactive. 

• To exit the application click Exit or click the top-right X button. 
 

2. In the FlexRip Configurator, select the ‘HP Indigo’ flavour. 
 
In the main window an Installed Flavours dropdown list selector is displayed with the 
FlexRip/HP Indigo instances installed on the system.  

• When FlexRip/HP Indigo is selected the installed instances will be displayed 
in the Dispatchers panel. 
A FlexRip flavour instance is a completely independent RIP of the same 
FlexRip flavour, having its own configuration and accessibility.  
An instance is also called a Dispatcher because each instance has its own 
dispatching executable.  
This executable must be started up for the RIP to be ready to accept ripping 
requests. 
• Each instance/dispatcher has a separate icon on the desktop and a 

separate entry in the Programs folder (under Esko and the particular 
FlexRip flavour folder). 

• You need an instance per device you intend to drive with the FlexRip. For 
each instance a license is required. 

 

Note 
The terms ‘dispatcher’ and ‘instance’ will be used interchangeably in the further 
discussions. 

 

3. Select the FlexRipHP Indigo dispatcher. 
In the Dispatchers panel a particular FlexRip flavour instance can be selected for 
configuration or checking. When an instance is selected, all buttons become active. 

4. Click ‘Modify’, click ‘New’ and enter an appropriate Configuration name. 
5. Click OK. 
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When the FlexRip/HP Indigo instance is selected the following actions can be performed: 

• Backup: creates a backup of all the installed FlexRip flavour configuration settings. 
• New: creates a new instance for a particular FlexRip flavour. 
• View: allows you to view the settings of the selected FlexRip flavour instance. 
• Modify: allows you to change the settings of the selected FlexRip flavour instance. 
• Delete: deletes the selected FlexRip flavour instance. 
• Change Type: changes the output device type for the selected FlexRip flavour 

instance. 
• Exit: stops the FlexRipConfigurator application. 

 

The following menu entries are available in the task bar of the main window: 

• File 
• New Dispatcher: creates a new instance for a particular FlexRip flavour (same as 

button ‘New…’). 
• Dispatcher Properties: displays the properties of the selected FlexRip flavour 

instance (only active when an instance is selected). 
• Restore: restores the backup of a complete FlexRip flavour configuration setting 

or of a single FlexRip flavour instance configuration setting. 
• Create PPD: not applicable for FlexRip/Indigo 
• Create All PPDs: not applicable for FlexRip/Indigo 
• PPD Properties: not applicable for FlexRip/Indigo 
• Exit: stops the FlexRipConfigurator application. 

• Help 
• About FlexRip Configurator: displays the FlexRipConfigurator version information. 
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The Dispatchers panel displays the installed instances of the particular FlexRip flavour with 
the following information: 

• Name: the name of the instance. 
• Type: the device type for the instance. This is the device the FlexRip flavour instance 

will drive or generate output for. 
• EskoLink Port: Each FlexRip flavour is allocated a default port number at software 

installation time. 
The default EskoLink port number for the FlexRip/Indigo flavour is 3010. 

 

Warning 
The FlexRipConfigurator does not permit to make changes to a FlexRip flavour instance 
for which the Dispatcher is running. The particular dispatcher executable must be 
stopped first. 
 

 

5.tif 

 



 

 Page 21 of 210 

 

6.tif 

 

Configure the Path settings 
 

(in this example the name of the Press PC is \\indigo) 

 

• Output: click the [...] button and select the directory that corresponds with the hotfolder on 
the HP Indigo system. This is the hotfolder where the JLT file will be written. See the 
section Mapping Hotfolders of the HP Indigo Press for more information. 

 

• Images Path 
The Paths group contains location of the Master JLT file and of all the variable JLT files 
(images). The output folder of the RIP is the hotfolder on the press.  
Please note, that all of the paths must use the UNC format, with the 'Images on Press' 
field being the only exception, since this path is used by the press to access the variable 
JLT files stored at its local drive.  

 
Typical paths look similar to this: 
 

Output:  \\indigo\jobs\press\input\lan 
Images on Rip:  \\indigo\jobs\press\images 
Images on Press:  S:\jobs\press\images 
 

Access to the Press PC 
 

o The WorkFlow Manager user BGSYSTEM must have write access to the 
hotfolder of the press PC. If not, the 'RIP to WS4000 Series' task will error out 
when writing the Master JLT to the hotfolder. 
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o The configuration of access rights depends on the OS where the WorkFlow 
Manager server runs: 
• Windows 2000 Server – make sure that you have access to the Administrator 

account of the press PC. Create the user BGSYSTEM on the press PC with 
the same password as the one on the WorkFlow Manager server system and 
grant this user access to the required folders. 

• Windows 2003 Server 
o Log in as user BGSYSTEM on the WorkFlow Manager server. 
o Map the hotfolder of the Press: 

Open a command (DOS) window 
 
net use \\\indigo\jobs\press\input\lan 
/SAVECRED 
user: . . . 
password: . . . 
 
/SAVECRED stores the credentials permanently. During subsequent 
logons the share on the press will be automatically accessible. 

 

 

7.tif 

 

The HotFolder directory is in this case \\indigo\jobs\press\input\lan 

 

 

Configure the other settings 
 

• Paper on Output Media:  
Always select “From Job” and “Roll Fed” as jobs cannot be merged on the HP Indigo. 

 

Some "press specific options" used by the HP Indigo press during processing of the job: 
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• Resolution: 812 
• Screen: HDI-180  

(you can keep value to "Default" to not overrule settings made on press) 
• LUT: 05  

(you can keep value to "Default" to not overrule settings made on press) 
 

Configure the Inks 
 

• Set 
o CMYK: separates to CMYK. 
o HP IndiChrome: separates to the 6 IndiChrome inks (CMYK, Orange, Violet). 
o HP IndiChrome Plus: separates to 7 IndiChrome inks (CMYK, Orange, Violet and 

Green). 
o User defined: allows the user to define the inks in the Inks tab. 

 

Note 
If you want to use both CMYK and Indichrome output, you have to make 2 
configurations, one with “CMYK” selected and the other with “HP IndiChrome” 
selected. 

 

• Generate M1 separation 
If the box is checked, Orange, Violet (and Green) are printed on the HP Indigo press with 
the same screen angle as Magenta. In the zones where OVG overlap with Magenta this 
results in moiré. When activating M1 the rip will generate an extra separation containing 
the Magenta in the overlap zones. The press operator is now able to use a different angle 
for this magenta 1 separation in order to avoid moiré. 

 

Lpi, Angle and Dotshape are greyed out because the RIP does not screen. 
Screening is performed at the press side, during printing. The screen can be selected 
in the HP Indigo front end. 

 

When printing in Indichrome Output  the dialog not only contains entries for C, M, Y 
and K but also for Orange and Violet. It looks as follows, after scrolling down in the 
list of separations. 

 

Color Management Proofer Profile allows you to select a destination profile for the 
HP Indigo device. However it only defines a filter that will be used later on in the 
workflow, i.e. in the Dispatcher, in WorkFlow Manager. The effect of the filter on 
these applications is as follows: 

 

• When selecting a Color Strategy in a WorkFlow Manager ticket, the list of Color 
Strategies will show only those that have the destination profile defined in the selected 
proofer configuration. 

• When a proofer configuration has a destination profile defined, you will not be able to 
change this in the WorkFlow Manager. 
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FlexRip Dispatcher Configuration 
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The Dispatcher is the •heart• of the FlexRip. It is both the ‘daemon’ (continuous automatic 
process) that makes the RIP run and the place where all queues and RIP options are set up. 
Each output device requires a new Dispatcher.  

This means that if you make files for 3 different output devices, you will have 3 Dispatchers. 

 

Note: Each Dispatcher needs a separate licence. 
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The Menus 
 

Rip menu 
The Server menu contains the following items: 

1. Clear History 
2. Send Job(s) 
3. Abort Job  
4. Restart PS Rip  
5. Exit  

 

 

9.tif 

 

Clear History 
 

Choosing Clear history will delete all messages in the History View selection. You will be 
asked to confirm first. As this deletes all entries in the history database, they cannot be 
retrieved. This •cleaning• will also delete the corresponding RIP log files. 

 

Note: It is normally not necessary to clear this history database manually. 
 
In the Options menu\Program Options, you will be able to set a limit 
for the amount of history entries that have to be remembered. If this 
number is exceeded, the oldest entries are removed automatically. 
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Tip:It is advised not to enter a high number for the amount of 
history entries. The higher the amount of entries allowed, the 
slower the History View and RIP logging will function. 

 

Send Jobs 
 

Grayed out: not available in FlexRip/Indigo 
 

Abort Job 
 

Abort Job stops the RIP (and as a consequence any current ripping process). Remember that 
the RIP is automatically started again as soon as another job comes in.  

You could choose to abort a job when you are sure you do not need the output (e.g. you 
know the input file was wrong or a mistake was made in the queue options).  

Output files that were already generated by the RIP are not automatically removed.  

 

Restart PS RIP 
 

Grayed out: not available in FlexRip/Indigo 

 

Exit 
 

This will stop the Dispatcher program (and the RIP). Clicking the close button of the 
Dispatcher dialog will have the same effect.  

You will be asked to confirm first. 
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Options menu 
 

The Options menu contains the following items: 

1. Program Options 
2. Queue Defaults 
3. Performance  
4. Rip Priority 
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Program options 
 

The program options are general Dispatcher settings. They can be set per Dispatcher. 
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• FlexRip Log Files 
You can decide here whether or not you want the RIP to create log files. They can be 
interesting to find out what happened if something went wrong. It is advised to always create 
log files.  

Log files can be viewed in History View and are physically located in the Logging folder. 

C:\Esko\bg_data_flexripindigo_v070\indigo\Logging 
 

• WorkFlow Manager Server Disk Mounting 
Enable Dispatcher mounts disks unless specifically mentioned otherwise. 

 

• Trace messages and History 
• Save Dispatcher Messages. It is advised to activate this toggle. •Trace 

messages• keep track of the general status of the Dispatcher. Esko will only 
consult these in case of problems. 

• Number of files used indicates the maximum number of trace files that will be 
stored. 

• Maximum number of messages in each file indicates the number of entries that 
will be stored in one and the same trace file. 

• Number of entries in History indicates the number of log files History View will 
show you. The number of entries in the History can be set as wished. 500 will 
probably be enough. This means that when entry number 501 appears, entry 
number 1 will be deleted. 



 

 Page 30 of 210 

• Input Queue Settings 
• Include Debug Options: When checked, an extra tab sheet in the default 

queue settings will appear: •Debugging•. Please activate this Debugging  tab, 
because it enables you to control the contents of the log files. This is 
especially interesting for fast troubleshooting by customer services. They will 
advise you which settings to change in order to speed up problem solving. 

• Include Tuning Options: Should not be active (again unless Customer 
Service asks you to activate it). 
Enabling the Tuning options makes a number of extra tabs appear in the 
Queue Settings: 

o CopyDot Tuning . 
o LineWork Tuning 
o Contone Tuning 
o Memory Tuning 

Note: Linework, Contone and Memory Tuning are specific 
tabs for our Customer Service department and may 
only be used to solve or find a workaround for a 
specific customer workflow or FlexRip problem. 

 

• Units: Can be set to INCH, CM, MM or MIL (1000 MIL = 1 Inch). 
 

• Advanced 
Not applicable in FlexRip/Indigo 

 

Queue defaults 
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An FlexRip can have several queues of: 

• different types 
• the same type 
Each queue will have its own settings (how to rip, where to write the output file…). The 
settings in Queue Defaults however are valid for all queues. We refer to the Queue 
Settings  chapter for more details on queue settings. (The different tabs look exactly the 
same). 

The priority of the settings  is described further on. 

 

Performance 
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Following settings will influence the performance of your FlexRip. 

• When your FlexRip has more than one processor (CPU: Central Processing Unit), 
then define here which processor should handle the RIP activity of that specific 
queue (and of that specific Dispatcher). 

• Distributing RIP kernel action over several processors is only interesting when you 
have several RIP actions taking place at the same time. A good setting for your own 
FlexRip (your personal Dispatcher(s) and your personal Queues) will be advised by 
your FlexRip Instructor. Only change these settings together with your FlexRip 
system manager and/or Customer Service. 

 

Rip priority 
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This field allows you to set the priority of the ripping process over other processes.  

 

PostScript: not available in FlexRip/Indigo 

 

• You might for instance have noticed that changing queue settings (working with the 
interface of the Dispatcher) is very slow when the FlexRip is ripping at that same 
moment. That is because the RIP process (the kernel) had all the priority.  

• Now, some customers will want to use applications on the FlexRip a lot (working with 
Dispatcher, IntelliCurve, Bitmap Viewer) and some almost never. The recommended 
setting is Normal. 
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Tools menu 
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The Tools menu contains the following items: 

1. History View 
2. Status Monitor 

 

History View 
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The Dispatcher program itself will not show you the list of actions that are finished. History 
View will. All further info on the History View  program can be found in a separate section. 
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Status Monitor 
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The Dispatcher program itself does not show any detailed information on the ripping action. 

The Status Monitor program of that Dispatcher will show you more. All further info on the 
Status Monitor can be found in a separate section. 
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Info menu 
 

The Info menu contains the following items: 

1. Ports 
2. About Dispatcher 
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Ports 
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The Dispatcher is the server program of the Status Monitor and History View programs. The 
Dispatcher ports are used by its client applications to be able to communicate with the 
Dispatcher. Technically they are TCP/IP socket port numbers. 

 

About Dispatcher 
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Shows the date and version number of the Dispatcher program. This is useful information 
when reporting some problem with Dispatcher. It is NOT the version of your FlexRip software 
(see FAQs). 
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Connected monitors 
 

The Tools menu allows you to start up a History View or Status Monitor of that (specific) 
Dispatcher. Both are actually client processes of that Dispatcher and count for a •connected 
monitor•. 

As there is no need to start up a History View or Status Monitor a second time, you will mostly 
see that the number of connected monitors is 2. If you see a number over 2 then you 
probably already started up these client programs and •minimized• them. This indicates that 
this number is only there for your information. 
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Input queue 
 

• EskoLink: ‘EskoLink (or previously ‘BarcoLink’ or ‘DigiLink’) is a queue that 
represents a link with the Server (WorkFlow Manager).  
This kind of queue will ‘receive’ RIP requests for Esko native files. 
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New - Queue Info - Delete 
 

New – Delete: 

Grayed out: not available in FlexRip/Indigo 
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Queue Info 
 

• To consult some info about the Eskolink queue. 
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Dispatcher Queue settings 
 

This chapter contains the following topics: 

1. Basic tab 
2. Tiff Gray output tab 
3. Rip Settings tab 
4. Native Input tab 
5. Intellicurve tab 
6. Debugging tab 
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Many of the settings that are explained hereafter  

• can also be set as print options  
• or can be set in the WorkFlow Manager for Esko‐native workflows  

 

But then, which settings will the RIP take into account? 

What if opposite settings occur?  

And what if options are not set?  

The next section explains how different settings interact. 
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Priority of settings 
When an operator has set specific options, the file ends up in a Dispatcher queue that also 
has its specific queue settings, and possibly also extra settings in the •default settings• 
window. Which RIP settings will then be taken? 

 

This is the order of how the RIP consults the settings: 

 

1. FIRST: Dispatcher: specific Queue Settings.  
• Queue settings will overrule all others. 

Settings you always want to apply should be set here. See the section •Workflow: 
flavors and hints• for an important remark on the settings •image• and ‘emulsion’! 

 

Note: Options that are set in the Dispatcher Queue Settings 
will be greyed out in the server tickets. 

 

2. SECOND: settings in the ticket.  
• On this level you can set the options that are job‐related. In the Esko workflow, the 

settings in the ticket will be taken. 
 

3. THIRD: Dispatcher: (menu •options•) Queue Defaults.  
• Queue Defaults are settings that apply to all queues. The RIP will only consult them if 

options are not set in the Dispatcher or the ticket. This means that they are only 
executed in case there is still a •none• setting to be answered! If a “none” settings is 
still not answered by the Queue Defaults, the default setting inside the FlexRip 
software will be taken. 

 

Tip: To set up a logical workflow, it is advised to set the 
options that are always applicable as high in the order 
as possible as these will overwrite occasional mistakes 
in ticket or print settings. 

Example: You always want to expose on a device at 2000 
DPI. Then enter the resolution setting in the Queue 
Settings. As soon as a setting is required only from 
time to time, you might consider: 

 - to put it in the name of the (newly made) specific 
queue. 

 - to leave the (default) queue settings on •none• and 
specify it (each time when wanted) in the ticket or 
PostScript file. 
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Note: A number of options, like output path and (scr)dgc can 
also be set in the FlexRip Configurator. These settings 
will overrule all settings mentioned above! To make 
you aware of Configurator settings, options that are set 
in the Configurator are greyed out in the Dispatcher, 
ticket and Queue Defaults. 

 

Basic tab 
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The Basic options allows you to decide on how the output should look. 

Warning! Do not enter 0 (zero) in a value field. It will 
be considered as a •hard• value and 
possibly overwrite others! Leave the value 
field ‘empty’ before clicking OK. 

 

Transformations: 
Scale 
Scale options can be used for real job scaling (whole job at 50 %) or for the flexo distortion 
factors (e.g. Horizontal: 0.982 ‐ Vertical: 1). It is advised not to set the distortion factor here 
(leave the fields blank!) as it is rather job‐related and it is easily set in the setting options in 
the ticket. 
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Warning:  If no scaling is required, then do not enter 
•1• as any value here will be seen as an 
actual queue setting that overrules all 
others. It is advised to leave this field blank. 

 

Imaging options 
Reverse 
Here you decide on either a positive image or a negative one. When set to •none•, this setting 
will be read from the server ticket. 

Mirror 
Here you decide on either a mirrored image or a non-mirrored one. When set to •none•, this 
setting will be read from the server ticket. 

Tiff Gray output tab 
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Location & Name 
• Output Location indicates the folder where your temporaty .ct files will be written. If 

you don•t specify a folder, the location specified in the default queue settings will be 
used. However, if required, you can use the Browse button to select a folder. 

• Output File name defines the name of the temporary .ct files and also the name of 
the final .jlt. 

It is possible to use template variables for the output file name: 
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• Template variables 
All variables must be specified between left and right angle brackets (< >). 

The variables currently supported are: 

• <file> (name of the file that is sent to the FlexRip) 
For the Esko native input this equals the job name of the PDF native (PDF,PDFPLA, 
PDFSTA, etc.) file name. 
For PS input this equals the name found for %%Title in the PS file. 
 

Note: If no name is found in the PS file, •Unknown• will be 
taken. 

• <ink> 
This indicates the color group + underscore + full ink name e.g. pms1000c_warmred 
 
• <sink> 
The short ink name will be used. For process colors this means e.g. C instead of 
cyan. 
For Pantone colors this means the PMS number or a shortened name like WAR for 
Warm Red. 
 

Warning!  Designer colors will still be shown with their 
full name preceded by the letter •D•. 

 
• <nink> 
The number of inks will be used, based on the ink table in the original job. 
 
• <page> 
For Esko‐native input, this variable will add the er to the output name in case of a 
multiment. 
 
• <date> 
This variable will add the date of ripping in numbers to the output file name. 
The format is •yearmonthday• (yyyymmdd). E.g. September 25 2003 will be 
20030925•. 
 
• <time> 
This variable adds the time of ripping in numbers to the output file name. 
 

It is also possible to give a hard name in the •Output file name• input field or combine 
variables with fixed elements. 

Some characters are not allowed in the •Output file name• input field. The following 

characters will automatically be replaced by an underscore_ ): • . • , • / • , • \ • , • : •. 

 

Compression algorithm 
Select the appropriate algorithm from the dropdown list.  

• Choose between LZW, PackBits, Uncompressed and None. 
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AntiAlias 
Anti-aliasing is relevant for the line-art objects in the design that require pre-processing to CT. 
Enable anti aliasing to smoothen the staircase effect in the generated CT for line-art objects 
that need pre-processing. 

 

RIP settings tab 
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All required parameters will be set through WorkFlow Manager (Proof panels). 
Therefore, you should not use the Dispatcher settings.  

Put (none) as Configuration Set and for Output (Proofer Settings tab). 
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Native Input tab 
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Screening: 
• No Screening applied in the RIP. 

 

Abort for images with scaled resolution below... dpi 
Checking this toggle makes sure a resolution check on incoming images is performed. 

• This option offers you the possibility to get the RIP abort the job if images below 
a certain minimum resolution are found.  

• The resolution is calculated after scaling (effective when placing the image, 
including a possible global RIP scaling) and is a very solid quality check before a 
bad output is made. 
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Intellicurve tab 
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Press Dot Gain Compensation 
 

Calibration 
 

NOT applicable for HP Indigo workflow 
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Debugging tab 
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This tool enables you to control the content of the log files. You can make your log files report 
basic info or you could have them report all kinds of details on the complete RIP action. 

 

Why is this so interesting? 
Extensive log files are very helpful when a problem occurs and you or our Customer Service 
are looking for an explanation and solution to the problem. Our advice is to always have 
extensive log files made. The actual log file can be consulted by double‐clicking the process 
number in History View (first column •job•) or can be opened in WordPad or Notepad 
(standard text editors from Windows). 

The log files (per Dispatcher) always reside in the Logging folder.  

Note that it is possible that the output folder has another name, that you specified while 
configuring the FlexRip.  

• The path listed below is the default path: 
C:\Esko\bg_data_flexripindigo_v070\indigo\Logging 
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To change a debug setting, select the debug option and enter the new value in the input field. 
The minimum and maximum values are indicated.  

 

Some advised settings: 

• Statistics: advised setting: 5 
• Extra profiling: advised setting: 1 
• Expose Ticket (exptdebug): advised setting: 0 
• Statistics on error: advised setting: 3.  

This will provide more info when errors occur. 
• Screening: advised setting: 0 

 

Warning! The higher the value, the more chance the 
system generates huge log files. 

 

In the History View  chapter, you will find some guidelines on how to read log files and in the 
appendix there is a section that explains some classic errors . 

 

Reset All: Will reset the debugging parameters to their default settings. 
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WorkFlow Manager 
You will use WorkFlow Manager 7.0 and later to generate output on the HP Indigo. The RIP 
panel contains no specific items for interfacing to the HP Indigo Digital Press. The user is 
advised to create a ticket for each preferred workflow to the HP Indigo (For example one with 
and one without Indichrome). These tickets will appear in the ticket lists. In case you regularly 
print to the HP Indigo, it is advised to add this ticket to your favorites. 

Starting WorkFlow Manager 
To start WorkFlow Manager, log on to your system if necessary and then do the following:   

1. Click Start, then point to Programs.  
2. Point to the Esko folder and then to the WorkFlow Manager Client version that you have 

installed.  
3. Click 'Esko WorkFlow Manager 7.0 Pilot'.  
4. The WorkFlow Manager startup screen will appear.  
5. The Pilot window will replace the startup screen.  
 

Or you can also simply double-click the WorkFlow Manager Pilot desktop icon.  

Concepts 
What is WorkFlow Manager?   

What is the Pilot?   

What is a Job?   

What is a Task?   

What are Tickets?   
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What is WorkFlow Manager?  
WorkFlow Manager is unique for its modular setup, offering tailored solutions and growth 
possibilities.  

 

WorkFlow Manager is a piece of server software on an operating system. The WorkFlow 
Manager client application ('Pilot') can be installed on any Macintosh or Windows PC in the 
network. As many as you want, no separate licenses are required. All these clients can use 
this Pilot application to view jobs or files, to get information or to launch tasks. 

 

WorkFlow Manager is not a file server. You may of course use the WorkFlow Manager 
server-PC as file server; But this is not required at all. WorkFlow Manager was designed to 
work with any data in the network that it is allowed to 'see' (WorkFlow Manager only sees the 
data containers you have shared).  

Using the Pilot application, you can filter and access your 'Jobs' through WorkFlow Manager. 
This has many more advantages than just looking at the files 'on disk' you have on your file 
server. WorkFlow Manager allows quick access without endless browsing; it allows filtering 
on metadata.  

 

What is the Pilot?  
The Pilot is the heart of WorkFlow Manager. It's the application that you can use to organize 
jobs and files, create and modify tickets, monitor tasks, control workflows and devices, etc.  

The WorkFlow Manager server software runs on a Windows server. Every WorkFlow 
Manager actions is performed through the WorkFlow Manager Pilot. This client software can 
be installed on any Mac and Windows PC in the local network. Depending in the WorkFlow 
Manager User Access Rights, the Pilot can be used to  

• manage the WorkFlow Manager Jobs database  
• administrater users and general configuration  
• manage background action tickets  
• launch background action tasks on the server  
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The Pilot looks like this:  

61.tif 

For more in depth information, please refer to the chapter on the Pilot 

 

What is a Job?  
 

• The WorkFlow Manager offers a powerful Job concept. A Job corresponds to a 
specific order of your customer. A WorkFlow Manager Job can be created manually or 
via templates 

• Each Job also has a number of associated files, such as the artwork files created by 
designers, print-ready one-up files and possibly also step-and-repeat files.  

• A Job has an associated Job Folder. This is the folder in which the various production 
files associated with the Job are stored. Typically this folder is located on a central file-
server and has a well-defined substructure including subfolders for artwork, images and 
step-and-repeat files.  

• A WorkFlow Manager 'Job' appears in blue and represents an entry in the WorkFlow 
Manager Job database. Such a blue Job represents a work in progress, an active to-do 
for the prepress department. That means that once the Job is finished it is best removed 
from the WorkFlow Manager Database. Of course you can leave the data where they are, 
to be re-used for another Job later on, for a re-run or a correction order.  

• The WorkFlow Manager Job concept has many advantages and will become increasingly 
important in future versions. If you use it incorrectly, you will miss out on a lot of beneficial 
features.  
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What is a Task?  
WorkFlow Manager Tasks are actions executed in background on the WorkFlow Manager 
server computer. You can use two different techniques to start them:  

1. via the Pilot user interface  
2. via Hotfolders (not all task types)  
 

WorkFlow Manager offers a number of tasks you can perform on a file, or on a folder. There 
are several kinds of tasks:  

1. Conversion tasks such as the Export to PDF task, 
2. The Rip task, 
3. The Device Output tasks  
 

A Task has settings and you can save these settings as Tickets. These Tickets can be 
reused. When a task is launched, you can monitor its progress in the Pilot.   

In a HP Indigo workflow only a limited set of tickets is available. 

 

The Pilot allows you to perform a number of tasks on a file, a folder or a Job. The settings of 
these tasks can be saved as tickets. There is a basic set of tickets: the defaults. You cannot 
delete or overwrite default tickets. You can change the settings before launching a task, but if 
you want to save the settings, you need to do so under another name. You can build your 
own ticket library. For a complete list of all tickets available on your server (both yours and the 
default ones), you have to consult the Pilot's Ticket View.  
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WorkFlow Manager Pilot 

 
Introduction and overview  
 

The Pilot is the heart of WorkFlow Manager. It's the application that you can use to organize 
jobs and files, create and modify tickets, monitor tasks, control workflows and devices, etc.  

The Pilot looks like this:  
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1. Menus 
2. Three icons control the kind of overview the Pilot shows: 

1. Containers Overview: lists all Containers defined on the WorkFlow Manager 
server. 
2. Job Overview: lists all Jobs known in the WorkFlow Manager Job database. 
3. Last used Job: jumps to the last Job you worked on.  

3. The Views. The view changes depending on what view you're in. 
4. Launch Favorites: 
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Launching a Task  
There are several ways to launch a task. Let's take a closer look at launching a task from the 
Pilot's Files View  

• In the Pilot, select the Files View from the View bar, (or choose 'Files' from the 'Go 
Menu'). 

• Select the Job you want to work in. You can do so by selecting the job from the 
dropdown list  

• Select the correct folder and the file you want to work with.   
• Select 'Launch With' from the File menu (or select 'Launch With' from the right-click 

pop up menu). Select a Ticket.  
• You can launch a task. There are several ways to actually launch one:  

o Select 'New Task' [CTRL + N] from the 'File menu' (or from the right-click pop 
up menu).  

o Choose a Task, modify the settings and click the ticket's  Launch button   or 
select Launch task from the Tickets's 'File menu'.  

o Select 'Launch With' from the 'File menu' or from the right-click pop up menu, 
choose a ticket and the task will be launched automatically.  

o Alt+Click a favorite in the 'Launch Favorite' pane. The task will be launched 
automatically.  

You can monitor the tasks progress in the Tasks View or in the Files View's Task panel.  

 

Menus  
 
File Menu  
 
The File Menu adapts itself to the selected View.  

• New / Create ... [CTRL + N]: depending on the view you're in, you can create or 
define a new Task / Imposition / Proof / Device / Milestone / Hotfolder / Ticket ...  

• Open [CTRL + O]: depending on what View you've chosen, you can open files, 
milestones, tickets, ...  

• Open with...: allows you to select the application in which you want to open the 
selected file.  

• New Window: opens a new window, with the same settings as the current one.  
• Close Window [CTRL + W]: closes the current window.  
• New Folder...: creates a new folder.  
• Get Data...: allows you to easily upload folders and files from an external medium like 

CD or DVD without leaving the WorkFlow Manager environment.  
 

Tip  

It is possible to upload files to the Files View via drag and drop. Files can be dragged  
from an Explorer window and be dropped either on a folder in the tree view or in the 
files table. 

 

• Get Data from FTP site (context menu only): Similar to uploading files from CD or 
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DVD, you can now upload files into your Job by downloading files from an FTP site.  
• Restore Data...: will 'copy' the archived job data into the selected location, but will not 

're-surrect' or create a job. If the selected location already contains files, they are 
overwritten. Please refer to the chapter 'Restore Jobs'  

• Delete [Del]: deletes the selected file(s).  
• Rename...: allows you to rename the selected file.  
• Change File Type...: allows you to change the selected file's file type. A dialog pops 

up, presenting a dropdown list from which you can choose the appropriate file type.  
• Info [CTRL + I]: opens an Information dialog for (each of) the selected file(s)/ 

folder(s). You can also click the Info button or select info from the right-click pop up 
menu. Please refer to the section on Info  

• Summary [CTRL + ALT + I]: offers information for two or more selected files/folders. 
Summary opens only one dialog in which the system summarizes the information of 
the selected files or folders.   

• Exit: closes the WorkFlow Manager Pilot and all applications launched from it.  
 

Info  
The Pilot offers a way to retrieve meta information about a Job, a folder or a file.   

There are four ways to get information on a file or folder.  

• Select Info from the File Menu.  
• Hit the Info button in the Pilot.  
• Select Info from the right-click pop up menu.  
• Select a file, folder or job and use the shortcut [CTRL + i].  

 

The bulk of this information is XMP driven. Extensible Metadata Platform (XMP) is a labeling 
technology developed by Adobe, it allows you to embed data about a file, known as 
metadata, to the file itself.  
 

 



 

 Page 58 of 210 

 

62.tif 

 

Info about a JOB 
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info about a FOLDER 
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Info about a FILE 
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Edit Menu  
The Edit Menu has two items:  

• Select All [CTRL + A]  
• Preferences...: opens the Preferences dialog.  

 

Preferences 
The Preferences dialog box consists of the following tabs:  

• Tickets 
• Files  
• Pilot  

 

Tickets  
• Show default tickets: toggle this option on or off to see or hide the default tickets.  
• Use bold ticket names in task launching menu  
• Units: select the unit you like working with for dimension (mm, inch) and resolution 

(ppmm, ppi).  
• Define the number of decimals you'd like the system to display.  
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Files  
 

Preview size allows you to define (in pixels) the size of the preview that you get when 
consulting e.g. the Info dialog.  
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Indicate which application should become the default application when opening Normalized 
PDF files from within the Pilot. Normalized PDF files have a .PDF extension, which implies 
that the OS will not make a distinction between Normalized PDF files and regular PDF files. 
By default PDF files will be opened by the OS with Adobe Acrobat Reader if it is installed. 
However, when working with the Pilot, you probably will want to see Normalized PDF files 
opened in an Esko editor. As making this distinction is not possible on OS level, you will have 
to specify here which application you prefer to use. So, if a PDF file is double-clicked in the 
Pilot, and it happens to be a Normalized PDF file, the application selected in the Files tab will 
be used. On OS level (e.g. in Windows Explorer or Macintosh Finder), Adobe Acrobat Reader 
will be the application that is started up when you double-click a Normalized PDF file.  

This preference will be taken into account  

• In the Files View, when double-clicking the file or selecting 'Open’ from the pop-up 
menu.  

• In the Task Monitor, when selecting ‘Open Output File’ from the pop-up menu.  
• In the To Do List, when clicking a URL link to a PDF.  
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Pilot  
You can indicate the Number of recently used jobs in the job selector. By default this is 
set to 10. Changes will be applied when you log on to WorkFlow Manager.  
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View Menu  
The View Menu allows you to modify the way the Pilot looks. It adapts itself to the selected 
View.  

• Toolbar: Hides or shows the toolbar.  
• Views Bar: Hides or shows the Views Bar, for more information, please refer to the 

section on Views 
• Tasks: Hides or shows the Tasks panel, this is actually a part of the Tasks View (.  
• Favorites: Hides or shows the Favorites.  
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• Organize Favorites: please refer to the section on Organizing Favorites 
• Show Job Tickets only: Shows only the Job Tickets.  
• Show Global Tickets only: Shows only the Global Tickets.  
• Show All Tickets: Shows both Job and Global Tickets.  
• Columns...: Lists the available columns from which you can choose the ones you 

want to see in the table.  
• Refresh [CTRL + R] Refreshes the part of the Pilot that has focus.  
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Adding Favorites  
 

Favorites are an easy way of keeping your frequently used tickets close at hand.  You an add 
Tickets to Favorites in different ways.  

• When you use the Pilot for the first time, the Favorites panel will invite you to right-
click to add favorites.  
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• If you have already selected a favorite, you can simply right-click the Favorites pane. 
A menu will pop up, containing options to add and organize your favorites.   
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• Select a ticket in Tickets view and choose 'Add to favorites' from the Ticket Menu.  
• When saving a Ticket, the 'Save As' dialog pops up, allowing you to name the ticket 

and defining the scope of the ticket, but also presenting the possibility to add the 
ticket to the Favorites. For more information, please refer to the chapter on Creating 
Tickets .  

• Select 'Organize Favorites' from the 'View' Menu. The 'Organize Favorite' dialog 
pops up.   
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The dialog lists all your favorites, the Pilot will only show the ones that you 
can use, depending on the file or folder you've selected.  
Click Add, the 'Add Favorite' dialog pops up.  
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Select the ticket(s) you want to add, and click OK. They will be added to the Favorites. 
 

Organizing Favorites  
Favorites are an easy way of keeping your frequently used tickets close at hand.   

Let's say you frequently use the same two RIP tickets. To make sure that launching RIP tasks 
with these specific tickets becomes a lot easier, you can add one single RIP  ticket to the 
Launch Favorites panel. There is no need to add all different tickets of the same task type to 
the favorites panel as adding one type of ticket automatically implies that all other existing 
tickets of the same type are available as well. When you move the cursor over the ticket, an 
arrow will appear. Click the arrow to select the appropriate ticket from the list.  

 

Tip Use Alt-click to immediately launch your favorite ticket.  

Select 'Organize Favorites' in the View menu to add, remove or modify your existing favorites. 
The 'Organize Favorites' dialog is also the place to rearrange the order of the tickets as they 
are displayed in the Favorites panel.  

 



 

 Page 67 of 210 

Columns  
The Columns dialog box lists the available columns from which you can choose the ones you 
want to see in the table. Use the arrows to move the items you want to see to the 'Show' 
column. Use the Move Up / Down buttons to order the columns left to right.  
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• Job Name: displays the job from which the task was launched.  
• Task Type: displays the kind of Task used.  
• Ticket Name: Displays the name of the used ticket.  
• File Name: displays the name of the processed file.  
• Started: displays when (date and time) the task was started.  
• Finished: displays when (date and time) the task finished.  
• Operator: displays the operator that started the task.  
• Annotation: indicates whether or not an annotation has been added to a task.  
• Task ID: displays the ID of the task.  
• Order ID: displays the order ID as indicated in the Job Setup dialog.  
• Priority: displays the priority with which the task was launched.  
• Server: displays the server on which the task was launched.  
• Progress: displays (in percentage) the progress of the task.  
• Phase: displays what the task is currently being executed.  
• State: displays the state of the task (waiting, running, done, failed, warning).  
• Launched: displays when (date and time) the task was launched. 
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Go Menu  
The 'Go' Menu offers all the Views and the 10 most recent jobs.  

• Files: jumps to the Files View.  
• Tasks: jumps to the Tasks View.  
• Devices: jumps to the Devices View.  
• Hotfolders: jumps to the Hotfolders View.  
• Tickets: jumps to the Tickets View.  
• Containers: lists all containers defined on the server (in the File View), all tasks (in 

the Task View), all defined devices (in the Device View), all defined Milestones (in the 
Roadmap View), all defined Hotfolders (in the Hotfolder View), all tickets (in the 
Tickets View).  

• Job Overview: jumps to the Job Overview 
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Job Menu  
The Job Menu groups all job-related actions.  

• New Job... [CTRL + ALT + N]: allows you to create a new Job, the 'Create New Job' 
dialog pops up. For more information, please refer to the chapter on Creating new 
Jobs 

• Go to Job... [CTRL + ALT +O]: opens the selected Job.  
• Job Setup... [CTRL + ALT +J]: Displays the Job information, you can edit the Job 

setup and save the modifications. 
• Find Job... [CTRL + ALT +F]: allows you to search for a specific job. For more 

information, please refer to the section on 'Find Job (.  
• Archive Job: allows you to select a Prepare to Archive ticket. For more information, 

please refer to the section on the Prepare to Archivetask.  
• Relocate Job: allows you to select a Relocate Job ticket. For more information, 

please refer to the section on the Relocate Jobtask  
• Restore Job...: allows you to restore an archived Job. Please refer to the chapter 

'Restore Jobs' 
• Import Job...: allows you to import jobs from folders or ZIP files on the network. for 

more info, please refer tot the section on Importing jobs 
• Export Job...: allows you to export Job data to a folder or a ZIP file.  
• Remove Job: removes the selected job. The system asks for a confirmation and 

allows you to decide whether you want to remove the complete Job (including files) or 
to remove the Job as a concept (leaving all files as they were, in an 'ordinary' folder 
on the hard disk).  

• Define Job Filters..: allows you to define your own filters. 
 

New Job [Ctrl + Alt + N]  
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You can create a completely new Job OR use an existing Job as a template.  

If you select 'New from existing Job' you need to select the Job you want to use as a 
template. You also need to select what elements of the existing Job you want to copy: files, 
folders, hotfolders, tickets and/or milestones.   
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Creating Jobs  
There are several ways to create a Job:  

Select 'New Job' form the Job menu. The 'New Jobwindow appears.  

Hit the Create Job icon (this button is available in all views).  

Select a folder and convert it to a Job by choosing 'New Job' from the 'Job' Menu. 'New 
Jobdialog pops up.  

Select a folder and convert it to a Job by right-clicking and choosing 'New Job' from the pop 
up menu. The 'New Jobdialog pops up.  

 

Job Setup  
WorkFlow Manager offers a powerful Job concept. A Job corresponds to a specific order of 
your customer. Typical Job information includes items such as the order ID, customer name 
and due date of the Job. Each job also has a number of associated files, such as the artwork 
files created by designers, print-ready one-up files and possibly also step-and-repeat files.  

A Job has an associated Jobfolder. This is the folder where the various production files 
associated with the Job are stored. Typically this folder is located on a central file-server and 
has a well-defined substructure including subfolders for artwork, images and step-and-repeat 
files.   

• This Job concept is mainly used to automate certain workflows, so most of its 
features are not applicable in the HP Indigo workflow. 

• Order ID and Job Name are filled in automatically (depending on the foldername), 
Job File Format PDF is the default, so nothing should be added in this panel. Just hit 
<OK>. 
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Find Job  
Allows you to search for a specific Job using a whole range of parameters. It also permits you 
to load filters (earlier defined) to search and to save the search parameters as filters, to be 
used in the Pilot.  

Select 'Find Job' from the 'Job Menu' [CTRL + ALT +F], the 'Find' window pops up.  

There are two menus:  

Job Menu  

• Open [CTRL + O]: opens the selected Job.  
• Close Window: closes the Find window.  

 

Filter Menu  

• Load filter: allows you to load a filter, you can choose from all Job filters defined on 
the server.  

• Save Search as Filter: allows you to use the search parameters to be saved as a 
filter, which will be added to the list of Job Filters.  



 

 Page 72 of 210 

 

The Criteria are the same as those available to define a Job Filter. For more information, 
please refer to the section on  Job Filters 
When your search yields results, they are listed at the bottom of the 'Find' window. Open a 
Job by double-clicking it, or by selecting Open from the 'Job Menu' or from the right-click 
menu.  
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Import Job...  
This task is part of the 'Exchange Job' family and comes along with Job Export... to exchange 
WorkFlow Manager Jobs between WorkFlow Manager servers on different sites.   

You can import a packaged job data folder or a packaged job zip file. A Job is collection of 
database entries (containing metadata, covering the items you can find in Job Setup) and its 
jobfolder (the actual data). This tool is about exchanging both. The Job setup part can be 
exchanged as it will be stored in the Job folder's subfolder /config, a hidden standard 
subfolder. Select the folder or Zip file from the Import panel. These can be located on all 
network shares to which the WorkFlow Manager BGSystem account has access.   

In the Import Options panel window; select the folder where you want to import the selected 
job. By default, the Macbinary files (if any) are unwrapped into the SFM Mac file format on the 
NTFS File system.  
Click OK.    
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Export Job...  
This task is part of the "Exchange Job" family and comes along with Job Import... to 
exchange WorkFlow Manager Jobs between WorkFlow Manager servers on different sites.  
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The Job Export tool allows you to collect all job data 'to a folder' or 'to a Zip file'. If you select 
'to a folder', the package folder name will be the same as the job name and will be created in 
the URL in the 'Folder' text box. If you select 'to a Zip file', the job package zip file name will 
be the same as the job name, as specified in the 'File Name' text field. In this case, the Export 
task will be a workflow task, launching a zip task to wrap the job package into a Zip file. The 
Zip subtask is run in the default CPU queue.  

You can select a remote folder location by clicking the 'Select ...' button. All shares on the 
complete network which are accessible for the WorkFlow Manager BGSystem account can 
be selected this way. If you can't browse for any reason, you can also type in a network share 
manually (and press Enter), but again, the BGSystem account should have access to that 
directory.   
If you check 'Remove the folders and files on disk', the Job record and the Job data will be 
removed from WorkFlow Manager.  

The Mac files in the selected Job get converted into MacBinary format by default. You can 
disable this by unchecking the 'Save Macintosh files as MacBinary' toggle.  
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Ticket Menu  
The Ticket Menu is only available when the Ticket View is enabled and contains the following 
items:  

• Copycopies the selected ticket.   
• Copy from other Job... ( 
• Import... ( 
• Export... ( 
• Add to favorites: adds the selected ticket to your favorites 
Note  
The Ticket Menu appears only when in Ticket View. 

Copy (Ticket Menu)  
Select 'Copy' from the Ticket menu to copy the selected ticket with a new name (and a new 
scope).  

The Copy ticket window pops up:  
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Enter a new name and choose the ticket's scope. Click OK.  

Copy from other Job...  
You can copy tickets from other Jobs. Select 'Copy from other Job' and a window pops up. 
Click the 'Select Job...' button, choose a job from which you want to copy a ticket, click select. 
All found Jobtickets will be listed, choose the one you want to copy and click 'Copy'. The 
Ticket will be copied to the current Job.  
 



 

 Page 76 of 210 

 

Import...  
Allows you to import exported tickets. A browser pops up, tickets have .tic as extension.  

 

Export...  
Allows you to export tickets. A browser pops up, hit 'Export Ticket'. Tickets have .tic as 
extension.  
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Task Menu  
The Task Menu is only available when the Files or Tasks View is enabled and contains the 
following items:  

• Open Task [CTRL + Alt + L]: opens the selected task(s), allowing you to relaunch 
them (with the same, or with modified settings).  

• Relaunch [CTRL + L]: relaunches the selected task(s) (with the same settings).  
• Open Output File [CTRL + Shift + O]: opens the output file that was generated by the 

task with the associated application. If no application has been registered, the default 
application for the selected file type will be used.  

• Go to Input / Output File: selects the input or output files of the selected task.  
 

The WorkFlow Manager Pilot will automatically switch to the Files View . It is possible that the 
folder containing that file is no longer available in the current containers, because it has been 
deleted or because the container is no longer available. In this case, an error message will 
appear. 

 

If the file is found, the container and path are opened in the folder selector, and the file is 
selected if it is still available. If the file is located inside a job, a dialog is shown asking you if 
the job should be opened or not. 
 

• Hold[CTRL + ;]: holds a task until it's 'released'.   
• Hold Until... [CTRL + Shift + ;]: holds a task until a predefined point in time.   
• Release[CTRL + G]: releases a task that's 'On Hold'.  
• Cancel [CTRL + /]: cancels the launch of a task.  
• Priority... [CTRL + U]: allows you to change the task's priority.  
• Move to History [CTRL + M]: moves the selected task(s) to the Task History (.  
• Annotation... [CTRL + E]: Add / modify an annotation. The annotation pops up, hit 

save to save modifications.  
• Log Info... offers you several possibilities of how to handle the log file. The log file 

contains all information that the system displayed in the 'Details panel' during the 
execution of the task. You can...  
 
• open the log file in the Pilot's log window. • open the log file with your favorite text 

editor. This will only work if the WorkFlow Manager client has access to the share 
bs_logging_v040 on the WorkFlow Manager Server. Once the file is opened in 
your favorite editor you can save it locally for future reference.  

• compose a mail message with the log file, the ticket and the input and output files 
attached.   
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• Define Task Filters... ( 
• Group workflows[CTRL + =]: workflows will be grouped in the Task list.  
• Related Workflow Tasks...: the system displays a dialog in which all related tasks 

are listed.  
• Show/Hide Details: shows or hides the Details pane.  

 

Defining Task Filters  
In order to make working with the Monitor easier, the system allows you to filter the Task list. 
You can choose between predefined filters or you may choose to define your own filters.  

You can do so by selecting 'Define Task Filters' from the Task Menu – available when the 
Task view is enabled. The 'Task Filters' dialog pops up.  
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Click 'New...' to define a new filter. The 'Modify Filter' dialog pops up.   
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 Page 80 of 210 

You're able to define a filter based on  

• Operator: shows only the tasks launched by the selected operator(s).  
• Date: shows only the tasks launched during a certain period or between two points in 

time.  
• Task Type: shows only the selected task types.  
• State: shows only the tasks with the selected state(s).  
• Server: shows only the tasks launched from the selected server(s).  
• Hotfolder: shows only the tasks launched from the selected hotfolder(s).  

 

Click OK, the system will ask for a name for the filter, the filter's name will appear in the Task 
Filters dialog and you'll be able to select it from the Task filter dropdown list. 
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Tools Menu  
The Tools Menu contains the following items:  

• To Do List: opens the To Do List. 
• Explorer: Opens the selected folder in Windows Explorer.  
• Task History 
• Cleanup Rules 
• Merger Monitor 
• Queue Monitor 
• Configure 
• Containers: allowing you to create and manage containers.  
• Customers: opens the Customers dialog, it allows you to create customers and 

manage the customer list.  
• Users: opens the Users dialog, it allows you to create  Users and grant them user 

rights. For more information, please refer to the section on Users and Access Rights.  
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Advanced Menu 
The Advanced Menu contains the following items:  

• Stop / Start Queue: Stop or start a queue.  
• Convert to Hotfolder: Converts the selected folder to a hotfolder, for more 

information, please refer to the section on Creating Hotfolders.  
• Convert to Normal Folder: Converts a hotfolder to a normal folder. It will delete all 

automatic actions, the system will ask for a confirmation first.  
• Start/ Stop Hotfolder Activities: Hotfolders are special folders with automatic tasks 

assigned to them. You can deactivate selected hotfolders, this means that the 
automatic tasks will not run. The status of a hotfolder is displayed in the 'Active' 
column in the Hotfolder list (in the Hotfolder View). 

• Edit Notification Templates: not applicable for FlexRip/Indigo 
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Help Menu  
The Help Menu contains:  

• Contents...: Displays the on-line help.  
• About...: Displays the About Splash screen, click it to close.  
• Shortcuts...: Displays a dialog listing all shortcuts.  
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Views  
WorkFlow Manager consists of a number of views that all throw a different light on a certain 
aspect of the application.  

• Files View 
• Tasks View 
• Devices View 
• Hotfolders View 
• Tickets View 
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Files View 
The Files View allows you to manage your Jobs, files, favorites, tasks, ...  
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1. Menu. For more information, please refer to the section on the Pilot's menus  
2. The Job Overview button is a shortcut to the Job View  

The Containers button lists all Containers known to the server.  
The Last Used Job button acts as a shortcut to the last used job.  

3. The Create New Job button  
For more information, please refer to the section on creating new Jobs  

4. The Create New Ticket button  
5. The Info button  
6. The File filter allows you to search the Files View by entering a string, and/or by 

selecting a file type from the list.  
7. Click Tickets and choose what kind of tickets you want to see: All tickets, Job tickets 

or Global tickets. 
8. Views  
9. Folders. Offers a tree view of the selected folders or Job.  
10. Contents of the selected job or folder.  
11. Favorites. For more information, please refer to the section on adding favorites 
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Jobs View 
This view is only visible when the 'Job Overview' button is selected. The Pilot lists all Jobs 
defined on the server.  
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1. Menu: the menus are discussed in the section on the menus in the Pilot 
2. Toolbar: please refer to the section on the Jobs View Toolbar 
3. List: lists all Jobs defined on the server.  
4. Job Details: display the details of the selected job. If you want to edit the Job Details, 

select 'Info' from the 'File Menu' [CTRL + I] or right-click a Job and select 'Info' from 
the pop up menu. For more information on the Job Details, please refer to the chapter 
on creating Jobs 
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Jobs View Toolbar  
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1. The Job Overview button is a shortcut to the Job View 
The Containers button lists all containers known to the server. 
The Last Used job button acts as a shortcut to the last used job.  

2. Job Overview dropdown list. This list allows you to jump to recently accessed Jobs, 
or to the Containers.  

3. Create a new Job  
4. Job Filter: Filter the list with one of the predefined filters.  
5. Enter (a part of) the name of the job in the input field and all jobs that have this part in 

their name will be listed. 
 

Defining Job Filters  
A Job filter helps you to find your way through the list of Jobs. You can select a filter from the 
filter drop down list. You can define a new filter by selecting 'Define Job Filters' from the Job 
Menu.   

The 'Job Filters' dialog pops up.  

 

The Job Filters dialog allows you to create, modify rename and delete Job Filters.  
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Tasks View 
The Tasks View gives a view on the current state of work in progress: the running tasks, the 
tasks waiting for execution and the recently finished tasks. If you want to keep information on 
what tasks were used and with what tickets, you can use the Task History.  

Note  

The list of running tasks depends on whether you're looking at the Containers, or simply at 
one Job. It also depends on any filters you might be using. More on filters in the section on 
Task filters.  

Use the Tasks View to:  

1. monitor the process of the tasks you launched.  
2. relaunch tasks.  
3. monitor the queues of your proof or expose devices.  
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1. Select the Tasks View by clicking the Tasks View icon or by selecting 'Tasks' from 
the 'Go' Menu. [CTRL + SHIFT + M] 

2. The Job Overview button is a shortcut to the Job View  
The Containers button lists all Containers known to the server.  
The Last Used Job button acts as a shortcut to the last used job.  

3. A dropdown list, allows you to quickly select other, recently accessed jobs.  
4. The Create new Job button , for more information, please refer to the section on 

creating new Jobs 
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5. Relaunch the selected task(s) the selected task(s) will be relaunched with the same 
ticket settings. You can also select 'Relaunch' [CTRL + L] from the Task Menu, or 
right-click a task and select 'Relaunch' from the pop up menu.  

6. Delete the selected tasks. You can also choose 'Delete' from the 'File Menu' [DEL] or 
choose 'Delete' from the right-click pop up menu.  

7. Task Filter (. The monitor offers a lot of information, but you're able to filter the data. 
You can select predefined filters from the dropdown list or you can make your own 
filter.   

8. Task List: lists all tasks, you can filter the list using the Task filters, you can sort the 
list by clicking on the column's head.  

9. Details: this pane shows the task's progress (when running), the current phase, on 
which server the task was started, when the task was started and when it finished 
and the total process time.  

10. Details: this pane offers more information on the selected task. 
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Devices View 
The Devices View allows you to monitor, start and stop your devices and device queues. The 
Devices View lists all devices configured on the server. 
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1. You need to select the Devices View, you can do so by hitting the Devices button or 
by selecting 'Devices' form the 'Go Menu' [CTRL + SHIFT +D].  

2. The New Job button  
3. The New Device button allows you to define a new device. You can also select 'New 

Device' from the 'File Menu' [CTRL + N]. The Configure tool will start up. 
4. The Start/Stop queues buttons allow you to start or stop the selected queue. You 

can also do this by selecting Start / Stop Queue form the 'Advanced Menu' or by 
right-clicking a device in the Device List. The devices' status is visible in the Queue 
State column.  

5. The Devices pane lists all Devices known to the server. It offers the Device name, 
Type, Rip Node, Port, Dispatcher State (running or stopped), Queue Name and 
Queue State (started or stopped). 

6. The Device Queue pane: displays the queue of the selected device: it offers 
information on the file name, the type of task that is running, the state, the progress of 
the task and date and time of launching.  

Hotfolders View 
Hotfolders are file-sensitive folders that automatically will start a certain, redefined, task as 
soon as they detect a file of the right file type. 

Example 
You could define a hotfolder as such that it automatically performs a Normalize PostScript / 
PDF / Illustrator 8.0 File task when a PostScript file is dropped. 
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This chapter discusses the following topics: 

• Working with the Hotfolders View  
• Creating a new Task Hotfolder  
• Creating a new JDF Hotfolder  
• Hotfolder settings  
• The hotfolder mechanism in depth  

 

Working in the Hotfolders View 
The Hotfolders View lists all defined hotfolders (when in container mode) on the Server or all 
hotfolders defined in a job (when in job mode). It offers all the necessary tools to create and 
manage them. 
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1. Hotfolders: lists the hotfolders defined in the selected job (or in all jobs, depending 
on the selection). 
To edit the hotfolder's settings, select 'Open Hotfolder' from the File Menu [CTRL + 
O], or double-click the selected hotfolder, or use the shortcuts in the right-click menu. 

2. New Job.  
3. Create a new Task Hotfolder . 
4. Details Pane: displays basic information about the selected hotfolder. 
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Creating a new Task Hotfolder 
1. Select the Hotfolder View from the View bar or select 'Hotfolders' from the 

'Go Menu' [CTRL + SHIFT + H]. 
2. Click the 'Create New Hotfolder' button or select 'New Hotfolder' from the File 

Menu [CTRL + N]. 
3. The 'Select Type' dialog pops up. There are two kinds of hotfolders: 

• Task Hotfolder: is a hotfolder that can be defined to process any kind of 
input file with any kind of WorkFlow Manager task. 

• JDF Hotfolder: is a hotfolder specifically set up for JDF data. 
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4. The 'Select Folder' dialog pops up. Select a folder you want to convert to a 
hotfolder and hit 'OK'. 
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5. The 'New Hotfolder' dialog pops up. This dialog allows you to add, modify 
and remove the automated tasks assigned to this hotfolder. Click 'Add'. 
Use the 'Browse' button, if you want to select another folder as Hotfolder. 
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6. The 'Select Task Type and Setting' dialog and 'Add Step' dialog pop up. You 
have to assign tasks to your hotfolder. Select a task form the 'Add Step' 
dialog and hit 'OK'. 

7. The selected task will be added in the 'Select Task Type and Settings' dialog. 
You can add more tasks to it to create a workflow (use the Add button) . 
When you're done, hit the 'Save and Close' button. 

8. The 'New' dialog pops up. 
Select the file types. Choose a Working Folder (the system copies the input 
file(s) to the 'working folder' and starts processing from there.) 
You may choose to delete the input files after the automatic task is finished. 
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You may want to add an annotation. 
Hit 'OK'. 

9. The task is added to the list of automatic tasks the hotfolder performs. 
10. Hit OK, the hotfolder is listed in the Hotfolder View. 

 

Hotfolder settings 
You define the settings of a hotfolder when you create one (see Creating a new Hotfolder . 
But you can always modify them to fit your needs. 

To view or edit the hotfolder settings, you can do one of three things: 

• Double-click a hotfolder in the hotfolder list. 
• Choose 'Open Hotfolder' from the 'File Menu' [CTRL + O]. 
• Right-click the selected hotfolder in the list, and choose 'Open Hotfolder' from the pop 

up menu. 
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The 'Open' dialog pops up. 

1. The hotfolder path.  
2. The operator (choose one form the dropdown list). 
3. You can make the hotfolder inactive for a period of time each day. Every active 

hotfolder needs resources, and therefore it is good practice to deactivate the ones 
you will not be using anyway. 

4. A list of automatic tasks. You can add, modify and remove automatic tasks to the 
hotfolder. 

5. You can export the selected task's ticket. A 'Save As' window will pop up allowing you 
to enter a name for the ticket. The ticket will be available throughout the system. 

 

Creating and editing automatic tasks in hotfolders: 

1. File Types: A task may work on more than one file type. However, the 
hotfolder will only process those file types you select from this list. 

2. If you want to delete the input files when the task is finished, check the 
toggle. 

 

Warning 
Hotfolders only support self-contained files. Files with external references are not 
supported. 

1. Working Folder: when a file is dropped on the hotfolder, it will be moved to another 
folder, the working folder, from where the actual task will start. 
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2. Annotation: you might want to annotate the task. 
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Tickets View 
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1. Create new job. 
2. New ticket. For more information on creating tickets, please refer to the section on 

Creating Tickets 
3. Copy the selected ticket. this is an easy way to make new tickets. for more 

information, please refer to the section on Copying Tickets (.  
4. Delete: deletes the selected ticket, default tickets cannot be deleted.  
5. Tickets for': use the file type to filter the list of tasks. It's an easy way to quickly find 

the ticket you want.  
6. Filter: this field allows you to filter the ticket list. Filtering is done on the ticket name 

only, not on the task name.  
7. Show Tickets: choose between the Jobfolder tickets global tickets and all tickets. The 

list will be updated according to your choice.  
8. List of Tasks and Tickets. The list is divided in two columns: Task Type and Ticket 

Name. Click the column heads to sort from A to Z or from Z to A. For more 
information on the different Tasks, please refer to the chapter on Tasks & Tickets (.  
Note  
When a new type of  device is created in the Configure tool, the ticket view of the will 
not list the appropriate ticket right away. Refresh button is not available. To get the 
ticket, leave the Ticket view and enter it again. Doing so updates the ticket list.  
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This chapter discusses the following topics:  

• Tickets 
• SmartNames 
• Creating Tickets 
• Two kinds of tickets 
• Creating Workflow Tickets 
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Tickets  
The Pilot allows you to perform a number of tasks on a file, a folder or a Job. All task types 
can be executed in many different and detailed ways and so have many options you can 
choose to change. The settings of these tasks can be saved as tickets. There is a basic set of 
tickets: the defaults. You cannot delete or overwrite default tickets. You can change the 
settings before launching a task, but if you want to save the settings, you need to do so under 
another name. You can build your own ticket library. For a complete list of all tickets available 
on your server (both yours and the default ones), you may want to consult the Pilot's Ticket 
View.  
Double-click a ticket in the Ticket View to open it or select 'Open Ticket' from the File Menu 
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1. Menus  

The File Menu consists of :  
• New... [CTRL + N]: allows you to create a new ticket.  
• Save [CTRL + S]: saves the current ticket, unless you have been modifying a default 

ticket. In that case, the system will ask you to provide another name.  
• Save As... [CTRL + Shift + S]: saves the current ticket under another name.  
• Close [CTRL + W]: closes the ticket.  
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The View Menu consists of :  
• Job tickets only.  
• Global tickets only.  
• All tickets.  

 

2. The Save and close button allows you to save and close the current ticket, if you 
were modifying a default ticket, the system will ask for another name by which to 
save the ticket.  

3. Steps: Use this part of the ticket to create workflows. 

4. Some tickets offer the possibility to define an Output path and a File Name.  
Use the SmartNames button to add SmartNames to the Output path and/or file name. 
Other tickets, e.g. the RIP ticket,  offer the possibility to define a Device. 

5. The ticket's settings, these differ for all tasks, for an in depth explanation on the 
various tasks and tickets, please refer to the chapter The tasks: an overview.  
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SmartNames  
What are SmartNames?  
SmartNames are text tags that will be resolved upon output, this means that their actual value 
may not be known before outputting. A SmartText like [date] is a variable until the task is 
actually launched. SmartNames are for instance used in the WorkFlow Manager panels to 
define the output folder and output name of the different tasks.  

There are several ways of adding SmartNames:  

• Hit the Add SmartNames button andthe 'Insert SmartNames' dialog box pops up.  
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Select the SmartName you want and click the 'Insert' button. the SmartNames will be added, 
in green, between square brackets.  

• You can right-click the field you want to add a SmartName to. A menu will pop up, 
choose 'Insert SmartNames ...', and select SmartNames from an extensive list.  

• You can copy/paste the strings from other locations. The shortcuts CTRL + C and 
CTRL + V will do the trick, but you can also use the right-click functionality and select 
'Copy' and 'Paste' from the pop up menu.  

There are several SmartName categories.  

Date:  

• Date: Inserts the current date.  
• Time: Inserts the current time.  

 

File Information  
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• File: The name of the input file.  
• File Type: Inserts the file type.  
• SmartID: Inserts the file's smart ID.  

 

FlexRip  
• Ink: This indicates the color group+underscore+full ink name e.g. 

pms1000c_warmred  
• NumberInk: Inserts the ink number, based on the ink table in the original job. 

Page: For Esko-native input, this variable will add the pagenumber to the output 
name in case of a multiment. 

• RipDate: This variable will add the date of ripping in numbers to the output file name. 
The format is 'yearmonthday' (yyyymmdd). E.g. September 25 2006 will be 
'20060925'.  

• RipFile (name of the file that is sent to the FlexRip): For the Esko native input this 
equals the job name of the PDF native (PDF, PDFPLA, PDFSTA, etc.) file name.  

• RipTime: This variable adds the time of ripping in numbers to the output file name.  
• ShortInk: The short ink name will be used. For process colors this means e.g. C 

instead of cyan. For Pantone colors this means the PMS number or a shortened 
name like WAR for Warm Red.  

 

Warning Designer colors will still be shown with their full name preceded by the letter 'D'.  

Imposition: 
•  

Job Information these are related to the Job properties 
• Customer Job Reference: Inserts the Customer job reference (it's a part of the Job 

setup (.  
• Customer Service Representative for the Job: Inserts the Customer service 

representative (it's a part of the Job setup (.  
• E-mail Address of the Customer Service Representative for the Job: Inserts the e-

mail address of the CSR (it's a part of the Job Setup (.  
• Job Category: Inserts the job's category.  
• Job Container Name: Inserts the job's container name.  
• Job container URL: Inserts the job's container URL.  
• Job CT URL: Inserts the job's designated image (CT) folder.  
• Job Customer: Inserts the job's customer.  
• Job Description: Inserts the job's description.  
• Job Due Date: Inserts the job's due date.  
• Job Due Time: Inserts the job's due time.  
• Job ID: Inserts the job's ID.  
• Job URL: Inserts the job's URL.  
• Job Name: Inserts the job's name.  
• Order ID: Inserts the job's order ID.  
• SubOrder ID: Inserts the job's suborder ID.  

 

Miscellaneous  

• Local Server: Inserts the name of the server on which the task runs.  
• Master Server: Inserts the name of Server running Task Manager.  
• Server: Inserts the name of the Master Server.  
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Path Information  

• File URL: Inserts the URL of the file's original location.  
• Job Temp URL: Inserts the URL of the job's 'temp' folder.  

 

Task Information:  

• Application name: Adds the name of the application 
• Application Name and Version: Adds the name of the application 
• Application Version  
• File Type Mode (GRS or PDF): Adds the mode in which the job was created.  
• ID: Inserts the ticket's unique ID.  
• Operator: Inserts the name of the operator who launched the task.  
• ShortID: Inserts the ticket's shortID.  
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Creating Tickets  
Tickets are settings used to launch a task. You can save these settings and use them again 
later. The Tickets Viewlists all tickets known to the server.  

There are several ways to create tickets.   

1. New Ticket...  
2. Modify an existing ticket 
3. Copy a ticket 
 
New Ticket...  

1. Hit the New Ticket button, or select 'New ticket...' from the File Menu [CTRL + N], 
when in Tickets View.  
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2. The 'Add Step' dialog pops up.  Select the appropriate Task Type and modify the 
settings if needed. 

3. Hit the 'Save and Close' button The 'Save As' dialog pops up.  
4. Enter a name for your ticket and choose whether you want the ticket to be available 

for the current job only or whether you want to use the ticket elsewhere in the system 
(Scope: Global). 

5. You can also add the ticket to your favorites, which means that the ticket will pop up 
in the Pilot's Launch Favorites panel. For more information, please refer to the 
section on Organizing Favorites 



 

 Page 105 of 210 

 

104.tif 

 

6. Hit OK.  

Modify an existing ticket  
 

Open a ticket by:  

• Double clicking a ticket in the Tickets View, the ticket pops ups, allowing you to 
modify the settings and to save them as a new ticket.  

• Double clicking a task in the Tasks View, the used ticket pops up, you can modify it 
and save the changes.  

• Selecting a file in the Pilot and choosing 'New Task' from the 'File Menu', select a 
ticket, change the settings and save them as a new ticket.  

• Right-clicking a file in the Pilot and choosing 'New Task', the selected ticket pops up, 
allowing you to modify the settings and save them.  

 

Copy a Ticket  
 

You can select a ticket in the Tickets  

• View and hit the copy ticket button or select Copy Ticket from the right-click pop up 
menu.  

• The 'Copy Ticket' dialog  
• Enter a name and define the scope. 
• Hit OK.  

 

Two kinds of tickets  

 
There are two kinds of tickets.  

• Global tickets  
These tickets are available for every Job. You can recognize them by their icon: a 
yellow ticket. 
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• Job tickets 
These are tickets assigned to a specific Job. You can recognize them by their icon: a 
blue ticket. These tickets will only be available when launching tasks from that 
particular Job.   
Note These tickets are physically present in the Job's JobFolder (in the hidden 
subfolder  
\config ). This means that, when you transfer a Job Folder to another site or system, 
that these tickets will travel with it.  

 

The Pilot has a button in the upper right hand corner of certain Views, this button allows you 
to choose what kind of tickets you want to see:   

• Global tickets only.  
• Job Tickets only.  
• All Tickets.  
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Creating Workflow Tickets  
A Workflow ticket is a ticket that contains the settings for two or more tasks that will be 
executed consecutively. Each task in the sequence will process the results from the previous 
task in the chain.  

Let's say you receive a PostScript file. You want to import it to a GRS file and then PS-Fix it. 
In WorkFlow Manager you can make a ticket which combines these tasks: we call it a 
Workflow ticket. When launched, all tasks will be executed consecutively.  

Example:  
1. Select the Tickets View, either by clicking the 'Tickets View' button in the Views bar, 

or by selecting 'Tickets' from the View Menu.  
2. Select the ticket you want your workflow to start with. In our example, we select the 

Normalize PostScript / PDF / Illustrator 8.0 File ticket. You can start with a default 
ticket, or choose another one. The ticket pops up. Modify the settings, if necessary.   

3. Add the next step in the workflow by clicking the Add... button. The 'Add Step' dialog 
pops up. In our example, we select the Rip to WS4000 series. Hit 'OK'  

4. The selected ticket pops up, allowing you to modify the settings.  
5. This step has been added to the workflow, you can view other steps by simply 

clicking them.  
6. You can insert other steps by using the ' Insert...' button, the 'Add Step' dialog 

will pop up again and add a step before the selected one.  
Click the 'Remove' button to remove the selected step. 
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7. If you're satisfied with the workflow, you can save it. Hit the 'Save and close' button or 
select Save As from the File menu. The Save As dialog will pop up, asking for a 
name and the scope of the ticket (. You can also opt to add it to your favorites 

8. You can use the workflow tickets the same way you would use an ordinary one. 
Workflow tickets have the word 'Workflow' attached in the task type.  
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Checking the logfiles 
 

Log Info (Task menu or right-click a finished task in the Task window) offers you several 
possibilities of how to handle the log file. The log file contains all information that the system 
displayed in the 'Details panel' during the execution of the task. You can 
• open the log file in the Pilot's log window. 
• open the log file with your favorite text editor.  

This will only work if the  client has access to the share bs_logging_v040 on the 
WorkFlow Manager Server. Once the file is opened in your favorite editor you can save it 
locally for future reference.  

• compose a mail message with the log file, the ticket and the input and output files 
attached. 
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E-Mail Configuration  
To configure the e-mail account on the WorkFlow Manager: 

• Open the Pilot 
• Tools > Configure 
• Select E-Mail Configuration 

 

The Mail Server tabsheet:  
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PostMaster is the one that will get a warning mail when an e-mail could not be 
delivered.  

SMTP Server SMTP Port  

Check with your IT department for the correct settings.  

When the SMTP server requests authentication, fill out the User and Password. 
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The Test tabsheet  
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Click the 'Test' button to see whether the mail system is working properly. The user as whom 
you are logged on will receive a test e-mail.  
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Configure: Creating an HP Indigo device 
 

We create a new proofer device that is linked to the HP Indigo Dispatcher. This can 
be done in the Configure application. Start it by selecting Configure from the Tools 
menu in WorkFlow Manager Pilot. 

 

In the left pane of the Configure application, select FlexRip•HP Indigo ws4000 
Series, open the File Menu and choose New. 
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Two tabsheets appear: 

• General 
• Queue 

 

General 
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• Type 
When you configure a new device, the system will tell you that the Type is Unknown. 

• Rip Node 
o Enter the FlexRip PC name and the EskoLink Portnr. that the specific 

Dispatcher has for its EskoLink queue. 
o Default for FlexRip Indigo is 3010 
o Fill out these fields before you click Synchronize with Rip. 
o This may take a few seconds. 

 

Queue 
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• Queue 
This field will have Approval1 Queue in it initially. This field will update automatically when 
you rename the device. 
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• Queue Job Limit 
A Dispatcher EskoLink queue can rip (= handle the expose-command of) 2 jobs at the 
same time. If you want the WorkFlow Manager Queue to allow sending 2 Expose 
commands at the same time, then set the job-limit of the WorkFlow Manager queue on 2. 
Putting this job-limit on 1 will result in each expose command to that EskoLink being 
handled one by one: the second job will be ripped after the first one is completely 
finished.  
Also remember the following rules: 

• having jobs ripped earlier on the Rip does not mean your output device can 
output them any earlier. 

• some people prefer the WorkFlow Manager queue 'job limit' on 1 because that 
guarantees the 'first in first out' rule. 

Do consult your workflow trainer or customer service for more advice on these Queue 'job 
limits'. 

 

Note 
When you have defined settings, do not forget to save them.  

• Click Save in the File Menu. 
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The Rip to WS4000 series ticket 
 

• Select the device on which you want to expose. 
• Launch the Task 

 
There are several ways to launch a task.  

1. In the Pilot, select the Files View from the View bar, (or choose 'Files' from 
the 'Go Menu'). 

2. Select the Job you want to work in. You can do so by selecting the job from 
the dropdown list 

3. Select the correct folder and the file you want to work with. 
4. Select 'Launch With' from the File menu (or select 'Launch With' from the 

right-click pop up menu). Select a Ticket. The task will immediately be 
launched with the appropriate ticket settings. 

5. You can also 'Launch' a task.  
There are several ways to actually launch one: 
• Select 'New Task' [CTRL + N] from the 'File menu' (or from the right-click 
pop up menu). 
Choose a Task, modify the settings and click the ticket's Launch button 
or select Launch task from the Tickets's 'File menu'. 
• Select 'Launch With' from the 'File menu' or from the right-click pop up 
menu, choose a ticket and the task will be launched automatically. 
• Alt+Click a favorite in the 'Launch Favorite' pane. The task will be 
launched automatically. 

6. You can monitor the tasks progress in the Tasks View or in the Files View's 
Task panel. 

 

The Rip to WS4000 series task has 5 tabsheets 

1. General  
2. Inks  
3. Advanced  
4. Pre-Rip  
5. Output ( 

 

Note 
The fields in gray are the presets that are defined in the Dispatcher Queue settings. 
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General tab 
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Device 
 

• Select the device on which you want to expose. 
 

Transformations 
 

• Scale V and Scale H 
Define here in % the requested vertical or horizontal scaling. Scaling direction is always 
applied ‘as the file is ’ (so the V and H are the V and H as you see them in the editor). 
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• Rotate 
Choose the requested rotation from the list. Rotation is counter clockwise. 

 

• Fit on Paper 
Scale the jobsize up or down to fit the requested papersize – scaling and rotation is then 
grayed out because this will be done automatically. 

 

Positive-negative 
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Define whether you want a positive or negative output file. 

 

Mirroring 
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Choose whether you want mirroring or not. 

 

Original size (Margins included) 

The system provides the original Job size, margins included. 

 

Output Size (Margins included) 

The real output size. The size shown here is the original job size influenced by the scaling 
factors (and/or distortions) and the chosen rotation. 

 

Marks 

Select a Mark Set from the dropdown list. These marks were created (in a central database) 
by the SmartMarks tool in the LineWork editor (menu ’Production’). 

 

Dot Gain Compensation 

• Single Curve: Select the preferred DotGain Compensation Curve. 
• Automatic: Select the preferred Screen based Dot Gain Curve. 
• Platemaking DGC: displays the platemaking DGC defined (if any) in the FlexRip 

Configurator. 
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Inks tab 
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All Inks 
The standard behavior of the default tickets is to offer all inks in the job(s) to be exposed. 
Deactivating ‘All Inks’ opens an ink-list panel where you can select specific inks. 

The list contains ink names, LPI, angle. If you are granted the user access right 
“Inkremapping in inks panel”, you can edit the inks. 

• Double-clicking the color swatch opens the Edit Ink dialog: 
You can edit Lpi, Angle and Dotshape. Hit 'OK' to apply the changes, 'Cancel' to close the 
dialog without applying the changes and 'Reset' to reset all values to default ones. 
Use 'On Top Of' to output inks on top of each other in the same output file. This is 
common when you use different lineatures for 1 ink. 

 

Use technical inks in output 
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In normal circumstances technical inks are hidden when you save a job in the Linework 
editor. But there's a possibility to save the technical inks as visible. 

With this toggle the user can define whether he wants these visible technical inks  be 
exposed or not. 

 

Use varnish inks in output 
Merge Similar inks in One Separation 
Not applicable for the HP Indigo ws4500 
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Advanced tab 
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Hold In Rip Queue 
This option offers to hold the task in the rip-queue until someone manually eleases this task  

 

Choose between: 

• Don't change Y ruling: this is the default, the Y ruling is not adapted. 
• Change Y ruling: change the Y ruling, possibilities are: -15%, -7%, 0% (changes 

othing), + 7% and +15%. 

• Change Y ruling stochastic: same as the 'Change Y ruling' settings, but the 
dotshapes is adapted to the Monet dot. 
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Pre – Rip tab 
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The Pre-Rip tab contains options that are only relevant when the job really needs pre-ripping. 
The Pre-ripping mentioned here is the ‘simplification’ that can be necessary before the job-
objects can be offered to the Rip. The decision to do this is taken automatically. And even 
when this is done, the options are best left to their default settings. 

Special objects (in Scope PDF format) that require the need for this ‘simplification for rip' pre-
ripping are: 

• ‘Edge vignettes’ (vignettes with alpha channels effect on the edge of the object) 
• Barco Blends (=non contourized GRO-blends) 
• Warped CTs (warping done on Placed CTs) 

Pre-ripping results in making a plain CT of these special objects that the rip can handle them. 
The resolution of such a CT and the anti-aliasing can be set here. 
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CT Resolution 
• Custom: The CTs created during pre-ripping will be at the resolution given by the 

user. This is the default choice (with a value of 304.8 ppi) and guarantees the 
behavior of previous Software Suite versions. This option allows for maximum 
flexibility in CT resolution setting but is independent of output resolution. 

• Output: The CTs created during pre-ripping will be at the same resolution as the 
output resolution of the rip, with a maximum of 1000ppi. When selecting 'Output', the 
text field containing the CT resolution shows what that resolution will be, but remains 
un-editable. This option allows for the rip output to be optimal, but may slow down 
pre-ripping and may require more disk space. 

• Automatic: The CTs created during pre-ripping will be at a resolution as close as 
possible to 300 ppi, depending on the output resolution. This CT resolution is 
calculated in such a way that the output resolution of the rip is an integer amount of 
times this CT resolution. When selecting 'Automatic', the text field containing the CT 
resolution shows what that resolution will be, but remains un-editable. This option is a 
compromise between optimal rip output and fast pre-ripping using minimal disk 
space. 

 

Examples: 

• If the output resolution of the rip is set to 609.6 ppi, then the CT resolution will be set 
to 304.8 ppi. 

• If the output resolution is 600 ppi or 1200 ppi, then the CT resolution will be set to 300 
ppi. 

 

Specify the output resolution for the generated CT(s).  

• Default output resolution is 12 lpmm or 304 ppi. 
The Anti-aliasing toggle is relevant for the line-art objects in your design, that need pre-
processing and for which CTs are generated. Anti-Aliasing smoothens the staircase effect 
you get in the generated CTs of line-art objects that need pre-processing. 

 

Vignette Noise 
Smoothens the tone jumps or banding effect in vignettes by adding noise/grain (in %). The 
amount of noise can be specified in the noise field. The higher the value, the more noise 
(grain) is added. 

 

The Blend to CT toggle converts the Esko blend objects into a CT when exposing your job. 

 

Use the Smooth Blend toggle to set the steps of the blend objects to 255 steps when 
exposing your job. As long as Convert Blend Objects to CT is not activated, Smooth Blend 
appears dimmed. When Convert Blend Objects to CT is activated and Smooth Blend also, the 
generated CT will ignore the original steps of the blends of your Esko design. The amount of 
steps is set at the maximum which is 255. The goal is to obtain a fluent blend effect. 
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Output tab 
Note 
Output settings that have been specified in the Dispatcher Queue Settings, are preceded by a 
blue icon 
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Configuration Set 
Name of the selected configuration file. These configuration (“conf”) files represent specific 
behavior of the output device. 

 

Output File 
• Path: leave this empty to use the output path as defined in the Dispatcher (EskoLink 

queue – Output tab). If your EskoLink queue has no value for the output place; then 
you can define output folders here. 
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• Name: leave this blank to get an output file name based on the input file. Edit this to 
overrule this standard behavior. Only plain letters and numbers will be allowed. 
Other, unsupported characters (symbols) will be replaced by an _. 

 

Note 
Hit the SmartNames button to add SmartText. 

 

Job Options 
 

• Anti-aliasing 
When ripping to Unscreened Tiff the output tab offers the option to use Anti-Aliasing. 
Anti-aliasing is relevant for the line-art objects in your design, that need pre-
processing and for which CTs are generated. Anti-Aliasing smoothens the staircase 
effect you get in the generated CTs of line-art objects that need pre-processing. 

 

 

• Number of Copies 
Enter the number of Copies you need. 

 

Output Mode 
Choose between  

 

• Composite (select Color Appearance: Colored or Greyscale) and 
 

• Separate (select Color Appearance: Colored or Black and White). 
o Colored: all inks are converted to CMYK values 
o Grayscale: all inks are converted to gray values. 
o Black and White: if you want a Black & White proof. 

 

Color Management 
Use No CMS (all options are grayed out), Color Strategy (only Color Strategy is available) or 
Profile (only the profiles are available). 

 

• Source Profile 
Choose the Process you want to simulate on the proof here. This process can be a 
registered ICC profile or a BG Process. There are some default BG Processes on the 
system (e.g. crom_offs which stands for Cromalin Offset). If you have measured a 
BG Process yourself (e.g. for your own Flexo press), you will be able to select it here. 

 

• Destination Profile 
This is the profile for the proofer. Choose the proofer process that describes the 
colors of your proofer here (e.g. the characteristics of your proofer). Both BG Proofer 
processes and ICC profiles of proofers are available in this list. Also defaults are 
listed, e.g. ddcw_glossy, a description for a Digital Cromalin/WaterProof on glossy 
paper. If you measured your proofer using the HP Indigo Labels and Packaging Color 
Kit powered by EskoArtwork software, you will be able to select your Proofer process 
here as well. 
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• Rendering intent 
Possibilities are: 

o Relative (No Background): Use this option if you do not want any background 
simulation. The white point of the source will be mapped on the white point of 
the destination process. This rendering intent takes into account the ability of 
the human eye to adapt to the surrounding white. 

o Perceptual: This will result in no background simulation (white of reference 
colorspace is mapped on white of destination colorspace). Use this option if 
you don't care too much about an exact color match but you want the 
pictures at least to look nice on your proofer. It will give a visually pleasing 
result. If the gamut of the source is wider than the proofer, the entire gamut is 
shrunk so that it fits inside the gamut of the proofer. 

o Absolute (Background): Use this option if you want background simulation 
and you want an exact color match, including the paper simulation. 

o Saturation: Use this option if you care especially about saturated colors. This 
rendering intent will map saturated colors on saturated colors. 

 

Note 
For BGCMS profiles Perceptual, Relative and Saturation are in fact identical. 

 

• Black Mapping 
This option is only available if you choose a Barco destination process (not if your 
destination process is an ICC profile). Black will be mapped onto black or, in other 
words, the black separation will only be printed with black ink. In case you want to 
simulate a very dark black, which is darker than the black of your proofer, you might 
want to switch this option off. In this case all 4 proofer inks will be used to simulate 
the high density of the black. 

 

• Color Strategy. 
If you have prepared a Process link in HP Indigo Labels and Packaging Color Kit 
powered by EskoArtwork + (optional software), you can select it in the dropdown list. 
Link profiles describe a transformation from 1 device dependent color space to 
another. This is actually a concatenation of a forward transformation of 1 profile and a 
backward transformation of another profile. 
This means that all other options will be grayed out as the Link Profile takes complete 
care of the color management. 
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Normalize PostScript / PDF / Illustrator 
8.0 File / PPML 
 

Warning 
The PostScript/PDF interpreter extracts fonts embedded in PostScript, Illustrator and PDF 
files. Only Type 1 fonts embedded in a PostScript/PDF file will be extracted. The extracted 
fonts will be installed locally automatically. For copyright reasons extracted fonts can ONLY 
be used to view and output the particular PostScript, PDF or Illustrator job containing the font. 
Any other use of that font e.g. editing the text requires a license of that font. 
 

Note 
Type 1 fonts can be embedded in Esko PDF file. 
 

Flatten PDF Transparencies and layers 
Check the box to import PDF files as in Scope 3 (and lower). All transparencies and layers 
will be flattened. If not checked, a normalized PDF file will be created that contains all typical 
PDF features (like transparencies and layers). 

 

This ticket consists of seven tabsheets: 

 

• Pages  
• Color Management  
• Inks  
• Overprint  
• Images   
• Page Size  
• Other  
• Output  
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Pages 
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Select All Pages or specify a Range of pages. 

 

Split up a multi 
Check the box to divide the original multiScript file into smaller parts. 

You define the amount of pages to open (of the specified pages or range). Whatyou need to 
know: 

• Each part is stored as a separate Normalized PDF file. It is either stored locally or 
stored in the Output Directory. 

• Each part is stored with the name of the imported PostScript file followed by _001, 
_002, _0001_001... or it gets the Output Name. 
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Compose a Group of CT Images into 1 CT Image 
Some ArtPro files have tiled CTs, those are CTs which are actually divided into a number of 
little CTs (tiles). Some jobs are so large that there are thousands of these little CTs. 

Select this toggle to merge the tiles into one CT to improve the editability of the Normalized 
PDF and to optimize further processing. This option is selected by default, it doesn't matter if 
you import a file with no tiled CTs. 

 

Note 
When errors occur when a PostScript file is imported (e.g. a font is not found), the Merge 
Tiled CTs to one CT will not be performed. 
 

Merge Separated file to Composite 
Merges separated single-multiScript or PDF files to a composite file. 

 

Optimize Merged File 
This option optimizes the merged file. This is useful when you need to edit the imported file. 
This option becomes available when 'Merge Separate File to Composite Page' is activated. 

 

Note 
When errors occur when a PostScript file is imported (e.g. a font is not found), the Optimize 
Merged PostScript File will not be performed. 
 

Password 
You can enter a password for protected PDF files. 
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Color Management 
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• Destination Color Space  
• Spot Colors  
• RGB  
• CMYK and Gray  

 

Destination Color Space 
Here you define what colorspace the opened/imported document will have. 

 

Colorspace: 
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• CMYK 
• Grayscale 

 

Destination Profile:  
choose a color profile from the dropdown list. Currently only CMYK and Grayscale profiles are 
supported, you can choose between standard ICC profiles and Esko's HP Indigo Labels and 
Packaging Color Kit powered by EskoArtwork profiles. 

The 'Use PDF Output intent if available' toggle: in some PDF files, the PDF Output intent is 
defined (e.g. PDF/X-3).(Output intent the intended output color space.) If you want to use the 
color space as defined in the output intent, use this toggle. If you selected the toggle for a file 
without PDF Output intent, the chosen Destination Profile will be used. 

Output intent the intended output color space. 

 

Rendering intent 
• Relative (No Background): Use this option if you do not want any background 

simulation. The white point of the source will be mapped on the white point of the 
destination process. This rendering intent takes into account the ability of the human 
eye to adapt to the surrounding white. 

• Perceptual: This will result in no background simulation (white of reference 
colorspace is mapped on white of destination colorspace). Use this option if you don't 
care too much about an exact color match but you want the pictures at least to look 
nice on your proofer. It will give a visually pleasing result. If the gamut of the source is 
wider than the proofer, the entire gamut is shrunk so that it fits inside the gamut of the 
proofer. 

• Absolute (Background): Use this option if you want background simulation and you 
want an exact color match, including the paper simulation. 

• Saturation: Use this option if you care especially about saturated colors. This 
rendering intent will map saturated colors on saturated colors. 

 

Set Document Profile 
A Document Profile is the color space of the process inks used in the document. 

• Always: you can 'tag' a PDF Scope file with its Document Profile. This means that the 
file 'knows' what its Document Profile is, which may make further color conversion 
throughout a workflow more correct. 
If you selected the 'Use PDF Output intent if available' toggle, the Document Profile 
will be the same as the PDF Output intent (if the imported file had one). 

• From PDF File: Document Profile is taken from the PDF file, if there is an output 
intent defined in the PDF filethis option is only available when the Use PDF Output 
Intent toggle is selected). If there is no Output Intent defined in the PDF file, then the 
Document Profile is not set (untagged). 

• Never: Document Profile is not set. 
 

Spot Colors 
 

PANTONE inks 

• Keep All: No PANTONE inks will be converted to process inks. 
• Convert All: All PANTONE inks will be converted to process inks. 
• Keep list: All PANTONE inks will be converted except for those listed in the Inks tab. 
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Method 
• Use Destination Profile: PANTONE and Designer inks will be converted using the 

selected Destination Profile. This gives the most accurate color reproduction. 
• PANTONE Solids to Process (Euroscale). PANTONE inks will be converted to 

process inks according to a fixed conversion table provided by PANTONE. 
The result is independent of the selected Destination Profile. This assumes the 
Euroscale print conditions. 

• PANTONE Solids to Process (SWOP). PANTONE inks will be converted to process 
inks according to a fixed conversion table provided by PANTONE. 
The result is independent of the selected Destination Profile. This assumes the 
American SWOP print conditions.  

 

Designer Inks: 
• Keep All: No Designer inks will be converted to process inks. 
• Convert All: All Designer inks will be converted to process inks. 
• Keep list: All Designer inks will be converted except those listed in the Inks tab. 

 

RGB 
RGB will always be converted to process inks during import. 

 

RGB Method: 
Select one from the dropdown list 

The tasks: an overview 

April 2007 327 

• Source to destination profile: the user needs to specify both the Source Profile (RGB) 
and the Destination Profile (CMYK or Grayscale). 

• With Link profile: the user specifies a HP Indigo Labels and Packaging Color Kit 
powered by EskoArtwork Device Link Profile. this Link Profile implicitely determines 
the Source and Destination profiles. 

 

Source Profile / Link Profile: 
Select one from the dropdown list. 

 

Objects with RGB Profile tags: 
The RGB objects in a PostScript or PDF file may be tagged with a Color Profile. 

• Convert using the RGB Profile tags: The user may choose to use that Color Profile as 
a Source Profile (overruling the Source / Link Profile selected above). 

 

Tip 
In strictly controlled workflows, the embedded tags are probably accurate, so this 
option may be preferable. 

 

• Ignore tags: the embedded Color Profile will be ignored, the Source / Link Profile 
defined above will be used during conversion of RGB objects. 
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CMYK and Gray 
The CMYK objects in a PostScript or PDF file may be tagged with a Color Profile. 

The color percentages of untagged objects will always be preserved. For tagged objects, 
users have a choice: 

• Ignore tags, preserve percentages: the Color Profile tag will be ignored, the 
percentages will be those of the object's color. 

• Convert, preserve appearance: the objects' color profile will be taken into account; 
this means that their color values will change. 
The Gray objects in a PostScript or PDF file may be tagged with a Color Profile. 
The color percentages of untagged objects will always be preserved. For tagged 
objects, users have a choice: 

• Ignore tags, preserve percentages: the Color Profile tag will be ignored, the 
percentages will be those of the object's color. 

• Convert, preserve appearance: the objects' color profile will be taken into account; 
this means that their color values will change. 
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Inks 
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Use Job Parameters 
If Job parameters were defined for your Job, you can use this toggle to make sure the 
'Normalize PostScript / PDF / Illustrator 8.0 File' task uses these parameters. 

For more information, please refer to the section on Job Parameters . 

 

Use rulings, angles and dot gain compensation from PostScript file if available. 
If the PostScript file contains rulings, angles and dot gain compensation, these will be used 
when this toggle is selected. Other settings in this tab will be overruled. 

 

Apply Screen Swap Table 
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Select a screen swap table from the dropdown list. 

 

Inks table (double-click the fields to edit them). 
 

Default values, used when a ruling, angle or dotshape is not specified. 
Enter the default values for ruling angle and dotshape, the system will take these values 
when they are not specified elsewhere (i.e. in the PostScript file, or in job Parameters, ...). 
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Overprint 
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Strict overprint behavior. 
Strict overprint behavior: CertIn (the Esko input module) will honor the overprint parameter 
100% according to the rules mentioned in the "PostScript Language Reference" (in case of 
PostScript / EPS /AI import) and "PDF Reference Manual" (in case of PDF). 

This option *must* be set when the user wants to process test files like the Altona test suite or 
other test suites which verify overprint behavior correctness. This toggle controls how zero 
percentage inks are handled when reading composite files.  

When 'Strict overprint behavior' is switched on all zero percentage inks of a color are kept and 
correspondingly affect the overprint behavior.  

When 'Never strict overprint behavior' is selected, all zero percentage inks are removed. 
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• Never strict overprint behavior: all zero percentage inks are removed  
• Always strict overprint behavior: CertIn will honor the overprint parameter 100% 

according to the rules mentioned in the "PostScript Language Reference" (in case of 
PostScript / EPS /AI import) and "PDF Reference Manual" (in case of PDF). 

• Only strict overprint behavior for PDF: CertIn will honor the overprint parameter 100% 
according to the rules mentioned in the "PDF Reference Manual" (in case of PDF). 

 

Overprinting default is non-zero overprinting: Prevents overprinted objects with zero 
CMYK values from knocking out CMYK objects beneath them. 

 

Default 
To set the overprint mode that the conversion needs to apply when importing the file. 

• Opaque: Ignores any overprint of your job. 
• BG Overprint: Converts all overprint present in your PostScript job to BG Overprint. 
• PS Overprint: All PS overprint present in the job is imported correctly. (This is the 

default setting.) 
 

Pure Black 
To set the overprint mode for objects containing 100% black only.  

Possible Pure Black overprint modes in the dropdown list: 

• Default: As it is defined in the job. 
• Force Opaque: Forces Opaque for objects in 100% black and knocking out all 

underlying inks. 
• Force PS Overprint: Forces PS overprint for objects in 100% black. 
• Force BG Overprint: Forces BG overprint for ALL objects in 100% black. The black 

color is printed on top of other colors, instead of erasing the color underneath. 
 

Warning 
There are two problems: 

• Sometimes ink saturation can occur. 
Example 
100% black text on a 100% red (this is, 100% magenta and 100% yellow) 
background, results in three inks printed at 100%. 

• Black is best handled as knockout for flexo, since it is better to add a small trapping 
region than to make the complete black region overprint. 

 

Rich Black 
Set the paint mode for objects containing 100% black and at least one other ink. 

• Default: As it is defined in the job. 
• Force Opaque (masking): Sets the overprint mode to opaque for all objects 

containing 100% black and at least one other ink. 
• Force PS Overprint: Keeps the PS overprint for objects in 100% black and at least 

one other ink (overprint objects stay in overprint and opaque objects stay opaque). 
• Force BG Overprint: Sets BG Overprint for all objects in 100% black and at least one 

other ink. 
 

White 
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Possible White paint modes to select from the dropdown list: 

• Opaque: Forces all objects in white to Opaque. 
• Keep PS Overprint: Keeps the PS overprint for objects in White (overprint objects 

stay in overprint, opaque objects stay opaque) 
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Images 
 

 
110.tif 
 

Embed all images 
Toggle this on if you want to embed all 1–bit, 8–bit and native images. 

 

Link External Images (OPI, DCS, Helios, ...) 
Force the system to look for referenced images. 

 

Fail if not Found 
Activate this option if you do NOT want the system to continue importing / normalizing your 
PostScript file when it cannot find an image. When this option is not activated the imported 
(E)PS file will appear on screen but without the missing images. 
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Search Preconverted Files: this option forces the system to look for the GRx, CT or LP 
equivalent for the original EPS file. If this equivalent is not found, it will use the EPS in stead. 

 

The Optimize DCS LineWork toggle 

Without linework DCS optimization, the result after conversion of linework DCS files can be 
difficult to edit afterwards. However it will be correct when viewed in extended preview or 
RIPped. 'Optimize DCS Linework' will do an additional operation to combine the elements on 
each DCS plate to a composite and a more editable result. 

 

Images 
Available options are: 

• Use Most Recent: forces the system to use the existing images of a previous 
conversion of the same job. 

• Reconvert: forces the system to regenerate the images on-the fly. 
 

Use Masks 
Available in the dropdown list are: 

• PS Mask: Forces the system to take the PS mask present in the EPF file. The mask 
available in the external image is discarded. If no PS mask is present in the file, no 
mask will be taken. 

• External Mask: if any, PS Mask otherwise: Forces the system to take the mask 
present in the external image. The PS mask is discarded. If the external image has 
no mask, but there is a PS mask available in the EPF file, this PS mask will be taken. 

• External Mask: if any, no mask otherwise: Forces the system to take the mask 
present in the external image. The PS mask is discarded. If the external image has 
no mask, no mask will be taken. 

• No Masks: The PS mask and the mask of the external image are discarded. 
• Joined External and PS Mask: Forces the system to join the available PostScript 

mask in the EPF file and the available mask in the external image. 
 

Search directories 
To specify a list of directories to look for referenced images. Use the buttons 'Add' and 
'Remove' to optimize the Search Directories list. 

Clicking opens the directory selector. You can browse to the correct directory and hit 'OK' to 
add the directory to the Search Directory list. 

 

Path Translation 
To define an understandable link for paths from a platform to another platform. 

The Path Translation dialog opens, it has three columns: 

• From Platform: Use the dropdown list to select a platform from which the files are to 
be retrieved: NT, Macintosh, Unix or VMS 

• From path: specify the syntax of the path(s) of the platform you want to retrieve files 
from. e.g. Mywork:PostScript:job1 

• To Path: define the syntax of the paths so that the destination platform understands. 
e.g. Mywork/PostScript/job1 
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Example 
If you were to go from Macintosh to NT, the path translation would look like this: 
You can do the same for files: File Translation. 
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Page Size 
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The default  is PS Page Size. PS Page Size is the  found in the selected PostScript file for 
import. The dropdown list displays all possible options (Custom, A5,...). 

 

Reader's Spread 
To determine how the PostScript file, which has reader's spread format, must be opened. 

• Single Page: Forces the reader's spread in the PostScript file into single ut. 
• Double Page: Forces PS File into reader's spread format. When the PostScript file contains 
no reader's spread info, the single pages will be set as double pages. 
 

Scale vertical 
To enter the vertical scale percentage. 100 % is the original size of the PostScript file. 
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Scale horizontal 
To enter the horizontal scale percentage. 100 % is the original size of the PostScript file. 

 

Rotate 
Forces the system to rotate the PostScript File with the specified angle. The origin for rotation 
is bottom left. Possible angles in the dropdown list: 

• 0: No rotation is to be performed. 
• 90: Forces to rotate over 90 degrees counterclockwise  
• 180: Forces to rotate over 180 degrees. 
• 270: Forces to rotate over 270 degrees counterclockwise. 

 

Offset 
The original offset is Bottom Left. Specifying a positive vertical/horizontal offset moves your 
PostScript file upwards/to the right in relation to the bottom/right border. Specifying a negative 
vertical/horizontal offset moves your PostScript file downwards/left in relation to the 
bottom/left border. 
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Other 
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Substitute Missing Fonts 
Roman fonts By: Choose a default replacement font for the missing fonts for this job on your 
system. 

Japanese fonts by: Choose a default replacement font for the missing fonts for this job on 
your system. 

The Fail if not found toggle: The task will fail if the font is not found. 

 

Images 
 

Import 1-bit images as 



 

 Page 143 of 210 

• Intern: Images become internal black and white bitmaps. 
• Extern: Images are imported as external referenced LP files. 
• Contours: Images are contourized during import of the (E)PS file. 

 

CT display images 

Choose Yes to create a display image for the generated CT files on-the-fly. 

 

Output file display images 

Select the type of display from the dropdown list: None, Thumbnail or Image and Thumbnail. 

 

Miscellaneous 
Device resolution xxx ppi:  

Device resolution is the resolution used internally by CertIn during the normalization. Normally 
the produced output is not dependent of this internal resolution but in some rare cases like 
when converting RIP test strips or device specific tests it is important that this value is the 
same resolution of the final RIP device which will be used to print output. 

Virtual Memory limit MB. Default value for the virtual memory is 50MB. The limit is set on 1 
gigabyte. 

 

Convert text to contours. 

Note 
Conversion might increase the file size. 
 

Workaround Options 
 

Skip Images 

To open the (E)PS file without linking to external images or converting embedded images. 

 

Preserve Quark trapping 

Forces the system to keep the trap strokes made by QuarkXpress. 

 

Disable optimizations 

Vignettes recognition and optimization for Photoshop Multitone images are performed 
(whenever possible) when this option is not activated. Sometimes after updating your DTP 
applications, Esko-Graphics can no longer perform the optimization and the conversion of the 
(E)PS file might fail. Switching this option ON will allow you to import the (E)PS file. 

 

Show PS comments 

All PS comments present in the (E)PS file are displayed on screen. 

 

Disable OPI 
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This option is valuable when you are importing (E)PS files of QuarkXpress containing high 
resolution Tiffs files for which the option 'Include tiff, omit ...' or 'Include all' was activated. In 
this case, when importing such a file and if Link External Images is activated, the matching for 
the TIFF files will surely fail. It fails because at the time the (E)PS file was generated OPI 
commands were also inserted for the TIFF files. Therefore the system will try to link to images 
for the Tiff files. To overcome this, activate Disable OPI. 

 

Show external images searches 

Displays the path(s) in which the system has found and linked to external images. 

 

Optimize Illustrator Patterns 

Illustrator writes patterns in a different way than PostScript does, default behavior is that 
Illustrator patterns will be optimized. 

Normally this speeds up the further processing (less linework in your file) sometimes, though, 
the optimization itself may take some time. 

 

Use PostScript rules for color conversion 

This toggle makes sure that all color management will happen using PostScript rules, in stead 
of BGCMS. Most options in the Color Management tabsheet will be grayed out. 

 

Recognize ArtScreen (lpi - angle) 

Check this box to make sure that an error is generated in case a (E)PS or PDF file with an 
unknown ArtScreen is imported. 
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Output 
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As a CT folder is no longer automatically created in every new JobFolder, you 

can specify your own favorite local images folder here. 

 

Image Creation Path 
Browse to a location or define one with SmartNames. 

If, during normalization, extra image data is created, you can indicate here where these 
images should be written. If no output directory is specified, then CT images generated during 
the conversion will be saved in the current working directory. 
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Limit Filename Length to Maximum 31 characters. 
Use this toggle if you want to make sure your imported files can be seen/read from/by all 
Apple operating systems (CTs that are kept on a Windows share but might be edited on a 
Mac for instance). 

 

Keep Layers (if possible) 
Keeps the Illustrator layer information. This will only work for Illustrator 8 files. 

It will not work for native Illustrator 9 files (or higher). 

When normalizing PDF 1.5 files (or higher), the 'Keep Layer' option will also preserve the 
PDF layers. 

 

Fit Media Box (margins) 
Allows you to automatically fit the margins. 
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More available tickets: 
 

Create Preview  
The Create Preview task is part of Scope's Native Image Support technology. It takes in 
images, verifies them, and creates a preview file that will be used in the viewing, proofing, 
editing and imposition applications. The Create Preview task should only be used if you want 
to pre-create previews of images, since the Normalize PostScript/PDF File task, Import Tiff-IT 
task, and the Create Wrapper File automatically create previews of images.  

Note  

These previews will only be created when the input job is stored in a Job. This task will not 
work on files stored in ordinary folders.  

 

The Create Preview task supports the following file types:  

. • TIFF  

. • TIFF_IT  

. • JFIF  

. • JPEG  

. • PSD  

. • EPS 

. • DCS  

. • PICT  
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Preview Mode  

• Keep Original: Enable this toggle to create previews in the same color space as the 
original file. If, e.g., an image is CMYK, the preview will also be displayed as CMYK.  

o Bitmap to Grayscale: If this toggle is enabled, the preview of the input file, 
being a bitmap file, will be displayed in grayscale.  

• RGB: The RGB option will display previews in RGB color space.  
• CMYK: The CMYK option will display previews in CMYK color space.  

 

Make sure the Create Thumbnail toggle is enabled if you want to create a thumbnail.  

Preview Resolution: The Preview resolution options allow you to set the resolution of the 
created preview image. Values are expressed in dots per inch (dpi).  

• Screen: Enable this toggle to create a preview at a resolution of 72 dpi.  
• Medium: Enable this toggle to create a preview at a resolution of 150 dpi.  
• High: Enable this toggle to create a preview at a resolution of 300 dpi.  
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• Other: Enable this toggle to create a preview at the resolution you specified in the dpi 
input box.  

Expand Variable data to PPML File 
 

Expand Variable data to PPML File(DeskPack 
Only) 
 

 

Please check the VDPack User Manual for more details about this ticket. 
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Export to GRS File 

 

Exports a Normalized PDF file to a GRS file.  
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External references: External references have to be converted, you can define what the 
system needs to do  

• Reconvert if recently updated: only updated references will be reconverted, all other 
conversions will be used as they were.  

• Use previous conversions: the existing conversions will be used, potential updates 
will not be considered.  

• Always reconvert: all external references will be converted at all times.  
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Put external references/images into Output folder Referenced files in PDF Scope mode 
will be converted to referenced external files in GRS mode, but where will they end up? There 
are two options:  

1. Converted external GRS files will be written in the output folder, next to the 
main GRS file.   

2. Converted external GRS files will be written in the original folder, next to the 
original external PDF Scope files.  

 

• Always: the converted external files will be saved next to the main file.  
• Never: the converted external files will be saved in the folder of the original 

files.  
• If relative: if the external PDF Scope files were close to the main PDF Scope 

file (subfolder, neighboring folder) the converted files will be saved in the 
output folder. If the external PDF Scope files were not 'close' to the main file 
(central smartmarks, logos, ...) the converted files will be saved next to the 
original files  

 

Fail when fonts are not found: when the fonts used in the file are not found the task 
will fail, when the toggle is not selected, the task will end with a warning  

Fail when external references are not found: the task will fail when not all external 
files were found.  
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Export to Normalized PDF File  
This task converts a file in GRS mode to a normalized file.  
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External references: External references have to be converted and are exported together 
with the input file. You can indicate where the external references should be written.  

• 'Write external references which are close to the input file to the output folder. All 
other external references will be written in their original folder'. Upon exporting, 
external references in subfolders or neighboring folder will be written to the output 
folder. External references in e.g. central folders will be written in their original folder.  

• Write all external references to the output folder.  
• Write all external references to their original folder.  

In case external references need to be reconverted, you can select one of the 
following options:  
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• Reconvert if recently updated: only updated references will be reconverted, all other 
conversions will be used as they were.  

• Use previous conversions: the existing conversions will be used, potential updates 
will not be considered.  

• Always reconvert: all external references will be converted at all times.  
 

External Images  

Use the radio buttons to indicate what should happen with the external images. You can have 
them copied to the output folder, or you can opt to leave them in their original folder.  

• Only images which are close to the output file  
• All images  
• None  

 

Fail when fonts are not found: the task will fail if not all the fonts were found.  
Fail when external references are not found: the task will fail when not all external files 
were found. 
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Fork  
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A workflow ticket consists of a number of sequential tasks. Each task is executed after the 
former was finished, each task involves processing the output file resulting from the former 
process. It is not possible to define a workflow ticket in such a way that more than one task 
involves simultaneous processing of the output file of the former. However, by inserting a 
Fork task in the workflow ticket these kinds of workflows can be build.  

The Fork task allows you to launch multiple tasks at once. This makes a few new types of 
workflows possible.  

• Workflows in which the order of the tasks is not important.  
• Workflows in which the required mix of file formats is not possible to combine in 1 

single workflow ticket.  

The ticket(s) that a Fork task will launch can now be 'Smart-selected’. E.g. If the Export to 
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PDF ticket contains a SmartName that indicates the customer name (as filled in in the Job 
Setup), then the fork ticket can generate different output, depending on the settings for 
that customer. Even the task type can be 'Smart-selected' which enables WorkFlow 
Manager to intelligently select the correct ticket, based on the type of action that 
needs to be performed. 
 

Defining a Fork task  

1. Select the Tickets View in the ”Views' bar, or in the 'Go' menu. Select the Fork task.  
2. Click the task's 'Add' button:  
3. It is possible to add a definition of a ticket by using SmartNames. You can e.g. define 

the task type or the ticket name as a SmartName. This can help you to limit the 
number of tickets to choose from when launching a task.  

4. The Add dialog pops up. Depending on which 'Add' button you clicked, different Add 
dialog boxes will appear.  

If you do not want to use SmartNames, you can simply select a task type 
from the list.  
If you do use SmartNames, you also select the task type from the list and 
indicate whether this new fork ticket is a Job ticket or a global ticket. Enter a 
new ticket name.  
 

5.  The selected ticket is added to the fork list. 
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Normalize EPF File  
The Esko Prep File or EPF is designed to improve the connection between the designer 
(Adobe Illustrator) and the prepress department.  
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External Images  

Embed all images  
Toggle this on if you want to embed all 1–bit, 8–bit and native images.  

Link External Images (OPI, DCS, Helios, ...)  
Force the system to look for referenced images.   

Fail if not Found  
Activate this option if you want the system to stop opening your EPF file when it cannot find 
an image. When this option is not activated the imported EPF file will appear on screen but 
without the missing images.  

Search for preconverted files  
This option forces the system to look for the GRx, CT or LP equivalent for the original EPF 
file. If this equivalent is not found, it will use the EPF instead.  

Keep native file format and verify  
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Certain file types like copydot, tiff and eps files are already in a reliable format. These files will 
be verified and left in their native format. On-the-fly preview files will be created and stored in 
the config folder in the Jobfolder.  

Note  

These previews will only be created when the input job is stored in a Jobfolder.  

The Optimize DCS LineWork toggle Without linework DCS optimization, the result after 
conversion of linework DCS files can be difficult to edit afterwards. However it will be correct 
when viewed in extended preview or RIPped.  'Optimize DCS Linework' will do an additional 
operation to combine the elements on each DCS plate to a composite and a more editable 
result.  
 

Images  
Available options are:  

• Use Most Recent: forces the system to use the existing images of a previous 
conversion of the same job.  

• Reconvert: forces the system to regenerate the images on-the fly.   
 
Use Masks  
Available in the dropdown list are:  

• PS Mask: Forces the system to take the PS mask present in the EPF file. The mask 
available in the external image is discarded. If no PS mask is present in the file, no 
mask will be taken.  

• External Mask: if any, PS Mask otherwise: Forces the system to take the mask 
present in the external image. The PS mask is discarded. If the external image has 
no mask, but there is a PS mask available in the EPF file, this PS mask will be taken.  

• External Mask: if any, no mask otherwise: Forces the system to take the mask 
present in the external image. The PS mask is discarded. If the external image has 
no mask, no mask will be taken.   

• No Masks: The PS mask and the mask of the external image are discarded.  
• Joined External and PS Mask: Forces the system to join the available PostScript 

mask in the EPF file and the available mask in the external image.   
 

Search directories  

To specify a list of directories to look for referenced images. Use the buttons 'Add' and 
'Remove' to optimize the Search Directories list.   

Click the directory selector to browse to the correct directory and hit 'OK' to add the directory 
to the Search Directory list.  

 

Path Translation  
To define an understandable link for paths from a platform to another platform. The Path 
Translation dialog opens, it has three columns:  

From Platform: Use the dropdown list to select a platform from which the files are to be 
retrieved: NT, Macintosh, Unix or VMS  

• From path: specify the syntax of the path(s) of the platform you want to retrieve files 
from. e.g. Mywork:PostScript:job1  
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• To Path: define the syntax of the paths so that the destination platform understands. 
e.g. Mywork/PostScript/job1  

 

 

Other  
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When exporting to EPF from Adobe Illustrator, the size of the Adobe Illustrator Artboard and 
the size of the crop box defined by the crop marks (if present) are stored in the EPF.  This 
allows you to fit the job borders to either the graphics, the artboard or the crop box when 
importing an EPF into Esko's Scope workflow.  

Scope components work with borders and margins. Use the dropdown list to Fit Borders to: 
Artboard, Graphics or Crop Marks.   

• Artboard: Default. Borders are fit to the artboard, some graphics may lie (partially) 
outside the artboard, hence, they will lie outside the borders too.  

• Graphics: the bounding box of all graphics will be used as borders, you want to use 
this when you want to make sure all graphics in the Illustrator job will lie in the 
borders.  

• Crop Marks: crop marks generated in Illustrator can also be used to define the 
borders.  
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Fit margins to graphics: default behavior is that the margins have the same size as the 
borders, but there are instances where you'd want to make the margins bigger than the 
borders. When the graphics lie outside the artboard for instance.   

Note  

This toggle is useless when you fit the borders to graphics.  

Convert text to contours: all text will be contourized.  
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Wait  
 

Use in a workflow ticket (chain) to postpone the next task to a relative or absolute time/date.  
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 Page 161 of 210 

Wait for Action (Checkpoint)  
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Use the Checkpoint task to modify your workflow in such a way that it stops at 
certain predefined points so that the user has time to check whatever needs to be 
checked. When a task uses a Workflow ticket containing a check point, that task 
will appear in the To Do List (.  
 

What: enter a short description.  
 

Who: choose a user from the dropdown list.    
Tip: In the 'Who' field of a Wait for Action task, the operator that launched the  
task can be used.  
 

When: enter a time and date.  
 

The message body: use this space to write extra information. 
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Step & Repeat Tabular  
 

With this module, all step parameters like number of one-ups vertically and horizontally, gap 
between one-ups, alignment and SmartMarks are completed in a WorkFlow Manager ticket 
after which the server will render the sheet layout to final output. The input fields of this 
WorkFlow Manager ticket also accept SQL queries so that already existing information, 
stored in a database, can be used to drive the sheet layout creation. Main benefit of this 
process is the single entry point for data: the typical production critical data required for step 
& repeat are usually known upfront and stored in a project or workflow management system. 
Avoiding that the operator has to type these values back in, based on a printed sheet, results 
in serious performance increases and reduction of human errors.   

Tabular typically means 'next to each other'. In this task, data can be entered in three different 
ways:  

 

• Manually entered numeric values  
• Esko formulas like [VPLATE] (a.k.a. the Esko legacy QuickStep formulas)  
• User - defined SQL queries that retrieve the values from external (DIE) databases 

 
This task consists of three tabsheets:  

• General tabsheet 
• Grid tabsheet  
• Rules tabsheet 
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General tabsheet 
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1. Origin: define the point of origin from which the repetition is to be built. Choose from 
four possible origins: 
top left, top right, bottom left, bottom right 

2. Unit: select a unit (mm or inch). 
3. SmartMarks: Select -if needed- SmartMarks from the dropdown list. 
4. Insert SmartNames button: Hit the SmartNames button to open the SmartNames 

dialog. The button is only enabled if the selected input field accepts SmartNames 
5. Plate:  

Size: enter the horizontal and vertical plate formula, value or SmartName(s).  
Shrink: enter -if necessary- a shrink value, formula, SmartName. 

6. Sheet  
Size: enter the horizontal and vertical sheet formula, value or SmartName(s) 
Offset: enter an offset value.  
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Sheet Position on Plate: position the sheet on plate by moving the red rectangle 
(the sheet) on the blue square (the plate) 

 

Tip  
Right-click a field to open an extra dialog:  

• Cut  
• Copy  
• Paste  
• Clear Contents  
• Insert Formula (choose between a global or a grid formula).  
• Insert SmartNames  

 

Note  
 
Some fields only accept SmartNames defined with Scope 'Step and Repeat' where as others 
also allow global defined SmartNames. (See Configure (page 461) for more information.)  
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Grids  

A repetition chart may be composed of several grids. If a repetition chart is composed of two 
jobs, there will be two grids. Each grid has its own number.  
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1. Grid number. This field highlights the selected grid.  
2. File Name  
3. Grid Mask To define the mask area around a job. Depending on where the 

repetition is positioned in the layout, a mask may or may not be required. Use 
the dropdown list to choose between 'none' or 'borders'. The dropdown list 
appears when you click the field.  

4. Grid Mask Bleed To extend a selected grid mask with a bleed. Specify the 
spread distance in the Grid Mask Bleed input box. Mask is spreaded but 
masks will not overlap.  

5. Vertical offset to sheet  
To define the top or bottom shift of the grid in relation to the sheet, depending 
on the setup of the origin.  
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6. Horizontal offset to sheet  
To define the left or right shift of the grid in relation to the sheet, depending 
on the setup of the origin.  

7. Vertical step  
To define the vertical distance between two steps of the grid.  
The distance is calculated from center point to center point of the job.  

8. Horizontal step  
To define the horizontal distance between two steps of the grid.  
The distance is calculated from center point to center point of the job.  

9. Vertical count 
To define the number of times you want to repeat your job vertically. 

10. Horizontal count To define the number of times you want to repeat your job 
horizontally.  

11. Angle To define the angle to rotate your job when repeated.  

12. Add/ Remove Grid  
Adds an empty grid. / Removes the selected grid.  

• Note  

The Ticket is automatically updated when you select multiple files in the pilot, the 
system adds enough grids to accommodate all the jobs you selected.  
 

13. Insert SmartNames...opens the 'Insert SmartNames' dialog, which allows 
you to insert 'Formulas' in the selected field.  

• Note 

Some fields (Grid Mask and Grid Mask Bleed) cannot contain formulas.  
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Rules  
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You can modify the task's behavior by defining rules.  

 

Define the 'Condition' and the 'Action'.  

➪Example  

We want to define a rule that states that all jobs with more than 8 inks shouldn't output.  

First you define the condition, then you define what happens if the condition is not met.  
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1. Enter the parameter you want to use as check.  
2. Choose an 'expression' from the dropdown list.  
3. Enter the value for the parameter.  
4. Choose the Action for when the conditions is not met from the dropdown list: 

OR the task finishes with a warning OR the task finishes with a warning 
(there's no output).  

 

Formulas  

Some of the fields work with formulas, they act as parameters and may represent different 
things. There are two different kinds of formulas: Global formulas (they define the whole of 
the repetition) and Grid formulas (they define the separate grids).  

Note  

A repetition chart may be composed of several grids. If a repetition chart is composed of two 
jobs, there will be two grids. Each grid has its own number.  

1. Global formulas:  
• VPLATEFIT: vertical plate size that fits around a repetition sheet and SmartMarks.  
• HPLATEFIT: horizontal plate size that fits around a repetition sheet and SmartMarks.  
• VPLATE: vertical plate size.  
• HPLATE: horizontal plate size.  
• VSHEETOFFSET: vertical offset of the sheet relative to the Plate.  
• HSHEETOFFSET: horizontal offset of the sheet relative to the Plate.  
• VSHEETFIT: vertical sheet size that fits around the repetition.  
• HSHEETFIT: horizontal sheet size that fits around the repetition.  
• VSHEET: vertical sheet size.  
• HSHEET: horizontal sheet size.  
• SHEETTOP: top position of the sheet relative to the Plate.  
• SHEETLEFT: left position of the sheet relative to the Plate.  
• SHEETBOTTOM: bottom position of the sheet relative to the Plate.  
• SHEETRIGHT: right position of the sheet relative to the Plate.  
• NROFINKS: number of non-technical inks (Technical inks will not be printed).  
• NROFGRIDS: number of grids  
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2. Grid Formulas: x = the grid number.  
• VLABELx: vertical size of non-rotated job.  
• HLABELx: horizontal size of non-rotated job.  
• VSTEPx: vertical step size, from center point to center point.  
• HSTEPx: horizontal step size, from center point to center point.  
• VSIZEx: vertical size of bounding box of rotated job.  
• HSIZEx: horizontal size of bounding box of rotated job.   
• VCOUNTx: number of vertical repetitions in grid x.  
• HCOUNTx: number of horizontal repetitions in gridx.  
• ANGLE: the angle of the rotation.  
• GRIDVSIZEx: vertical size of the grid (top-bottom).  
• GRIDHSIZEx: horizontal size of the grid (left-right).  
• TOPx: top position of the grid relative to the sheet.  
• LEFTx: left position of the grid relative to the sheet.  
• BOTTOMx: bottom position of the grid relative to the sheet.  
• RIGHTx: right position of the grid relative to the sheet.  
• BLEEDx: distance to spread the grid mask with.  

 

Example  

This example illustrates how one could use formulas to define an auto fill repetition: a defined 
sheet will be automatically filled.  
 

The formulas break down like this:   

1. First you define the vertical and horizontal count of the grid: the vertical count is the 
vertical size of the sheet divided by vertical size of the job, hence: VSHEET / 
VLABEL1.  
(The horizontal count: HSHEET / HLABEL1.)  

2. Then you are able to define the vertical (and horizontal step: vertical gap is the 
vertical sheet size divided by the vertical count, hence: VSHEET / VCOUNT1.  (The 
horizontal step: HSHEET / HCOUNT1  

3. Now for the verticaland horizontal offset: you want to center the repetition on the 
sheet. You can do that by defining the vertical offset as half the vertical step minus 
the vertical size of the job, hence: (VSTEP1-VLABEL1)/2.   
(For the horizontal offset: (HSTEP1-HLABEL1)/2 )  
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You can use the SmartMarks in the Step and Repeat Ticket:  
Use the 'Insert SmartNames...' buttons, or use the right mouse button shortcut.  
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Variable Data Printing 
 

Introduction 
 

Note 
Please check the specific VDP user Manual (VDPack user guide): this document describes in 
detail how to proceed with the VDP workflow. 
 

Variable Data Printing provides you the ability to print jobs with variable elements on digital 
presses while keeping in mind the needs of the packaging industry. 

A variable element can either be  

• a text,  
• a barcode or  
• an image.  

You can define these elements in a one-up document using Adobe Illustrator. Repetitions 
can be defined using the StepX plugin. Multiple grids with different one-ups per frame are 
supported. 

The WorkFlow Manager server divides repeated one-ups into a static and a variable part, 
placing the variable on top of the static part. The number of entries in the database defines 
the run length of the job. 

Based on the output generated by WorkFlow Manager, FlexRip creates bitmap files. FlexRip 
can also apply HP Indigo Labels and Packaging Color Kit powered by EskoArtwork color 
management to a job. Bitmaps are screened by the HP Indigo press itself. 

 

Note: 
The VDPack User Manual will explain only the topics related to Variable Data Printing. 
Knowledge of the WorkFlow Manager Pilot and FlexRip is recommended. 
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Illustrator PlugIns 

 
Introduction 
 

Note 
Please check the specific stepX and barX user guides: those documents describe in detail the 
particular plugins. 
 

stepX (see stepX user guide) 
stepX offers an easy to use interface to the tabular step and repeat task running on the 
server. It is has preview panels, it works with multiple documents, it has support for custom 
marksets and it can create a large number of output types to be picked up by your output 
device. 

 

barX (see barX user guide) 
Barcodes are just the visible part of often quite large systems frequently referred to as 
automated identification systems, which, increasingly, are proving to be some of the most 
cost-effective management tools, since they enable organizations to keep track of their goods 
and stocks in all kinds of situations in a fast, accurate and efficient way. 

With barX, you can add a dynamic barcode to your Adobe Illustrator document without 
leaving your application. Dynamic means that your barcode settings can be changed later on, 
even after you saved, closed and reopened your document. 

You select a barcode type from the dropdown list, select an orientation and you define the 
barcode in the dialog which changes according to the kind of barcode that you have chosen. 
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BackUp & Restore 

 
WORKFLOW MANAGER administration 

This chapter describes the procedures for performing different administrative tasks on 
the WORKFLOW MANAGER server. 

The following tasks are available. 

• Stop and start the WORKFLOW MANAGER server service. 

• Backup and restore an WORKFLOW MANAGER server configuration and configuring 
the WORKFLOW MANAGER server for scheduling automatic backup. 

• Configure an WORKFLOW MANAGER server system to use resources from another 
system. 

• Start and Stop the locally installed Application Server service and deploy the 
WORKFLOW MANAGER component in the Application Server. This task is only 
available when the appropriate licenses are available and the Application Server 
software is installed on the same system as the WORKFLOW MANAGER server 
software. 

• Manage Restore Points. 

The first chapter describes the general server administration task flow. The next 
chapters describe the specific required actions for the different tasks in more detail.  



 

 Page 174 of 210 

Server administration wizard flow 
To perform Server administrative tasks, perform the following steps. 

1. Log in as Administrator. 

2. Click Start in the bottom task bar, select Programs, Esko,  7.0 and click Server 
Admin. 

3. The “ Administration” window will be displayed. Select the  tab. 
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4. Either click Stop or Start the Server software for stopping or starting the server, 
Manage Server software Configuration: Backup and Restore for making a 
backup, restoring a backup or configuring the backup scheduling parameters, 
Manage RestorePoints for creating and restoring Restore Points, Redirect Central 
Resources for redirecting server resources or Manage the Local Application 
Server for performing tasks on the Application Server (not applicable for the HP 
Indigo workflow). 

5. Click Next in the welcome window. 
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6. Depending on the task selected, the wizard will display particular windows to select 
particular subtasks or to fill in the particular parameters required. See the detailed 
task description in the next chapters for more information on thesewindows. 
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7. For some actions, it is required that all clients are logged off, in that case the 
following informational window will be displayed at some particular moment in the 
wizard flow.  
Click Next to continue. The following window will display the list of all clients 
connected and will wait until all clients have logged off. At that moment the Next 
button will be activated. 
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All the connected clients will receive a warning message asking to log off. 

8. Clicking Disregard in the “Server Administration Wizard” will force an immediate 
shut down of all connected clients.  

9. Click Next to continue 

10. During the action a window will be displayed showing progress bars for Action 
Progress and possibly Overall Progress and reporting progress and logging 
information. At the end a message will be displayed that the action is finished. Click 
Next to continue. The examples below are shown for the stop server task. 
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11. At the end of the operation, click Finish in the “Completing the Server 
Administration Wizard” window. This window will typically give a summary of the 
actions that were performed, as shown below for the stopping the server task as an 
example. 

12. Click Finish to quit the “ Administration Wizard” window. 
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Starting and stopping the WORKFLOW MANAGER 
server 

 
Stopping the server 

When the Stop or Start the Server software button is clicked in the  tab sheet of the “ 
Administration” window and after clicking Next in the welcome window the procedure will 
check the server status. If the server is running, the following window will be displayed. 
Click Next to continue. 
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The “Connected Clients and Running Tasks” dialog will be displayed as described in the 
first chapter. Wait until all clients logged off or force the clients to log off. 

The action of stopping the server will start after clicking Next. A window will be displayed 
with progress indication and action and logging information. At the end click Next in the 
activity report window. Click Finish in the “Completing the Server Administration Wizard” 
window. 
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Starting the server 
When the Stop or Start the Server software button is clicked in the  tab sheet of the “ 
Administration” window and after clicking Next in the welcome window the procedure will 
check the server status. If the server is stopped, the following window will be displayed. 
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The action of starting the server will start after clicking Next. A window will be displayed 
with progress indication and action and logging information.  At the end click Next in the 
activity report window. Click Finish in the “Completing the Server Administration Wizard” 
window. 
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Backup/Restore of the WORKFLOW MANAGER 
server configuration 

When the Manage Server software Configuration: Backup and Restore button is 
clicked in the  tab sheet of the “ Administration” window and after clicking Next in the 
welcome window, the following window will be displayed. Select the appropriate action 
and click Next. 
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The following actions are available 

• Backup Server software configuration: only selectable when the WORKFLOW 
MANAGER server is configured as an WORKFLOW MANAGER Master or WORKFLOW 

MANAGER Stand-In server. 

• Restore Server software configuration: only selectable when the WORKFLOW 

MANAGER server is configured as an WORKFLOW MANAGERE Master server. 

• Configure Server software Backup: only selectable when the WORKFLOW 

MANAGER server is configured as an WORKFLOW MANAGER Master or Stand-In 
server. 
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Making a backup of the WORKFLOW MANAGER server 
configuration 

After selecting Backup Server software configuration and clicking Next in the “Server 
Administration Wizard” window, the backup will be started while displaying a window 
reporting progress and action and logging information. At the end click Next. 
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A window with a list of all backups present will be displayed, click Next to continue and 
click Finish in the “Completing the Server Administration Wizard” window. 
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Restoring a WORKFLOW MANAGER server configuration 
After selecting Restore Server software configuration and clicking Next in the “Server 
Administration Wizard” window, the “Connected Clients and Running Tasks” dialog will 
be displayed as described in the first chapter. Wait until all clients logged off or force the 
clients to log off. 

A window with a list of all backups present will be displayed, select the one to restore 
and click Next to continue. 
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A window will be displayed with a list of all the items that can be restored, with all the 
items selected by default. Select or deselect the items that are to be restored and click 
Next. 
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The restore operation will start and a window reporting progress and action and logging 
information will be displayed. At the end click Next to continue. 
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The WORKFLOW MANAGER server will be stopped. A window with progress indication and 
logging information for stopping the WORKFLOW MANAGER server will be displayed. At the 
end click Next. 
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The server will be started. A window with progress indication and logging information for 
starting the server will be displayed. At the end click Next. 
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Click Finish in the “Completing the Server Administration Wizard” window. 
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Setting up scheduling for WORKFLOW MANAGER 
server configuration backup 

After selecting Configure Server software backup and clicking Next in the “Server 
Administration Wizard” window, the following window with backup scheduling 
parameters will be displayed. 
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The following parameters are present: 

• The configuration backup will be stored in the destination folder: either fill in 
the destination folder specification or Browse… to the destination folder for the 
backups. By default the Backup folder in the ESKO  software installation folder 
(typically \Esko on the system disk) is selected. It is strongly recommended to 
use another disk for the backup folder. 

• The backup folders will have this prefix string: the data of the backups is 
stored in a folder per backup. The folder name consists of the prefix string 
followed by a timestamp in the format yyyymmddhhmm (with yyyy the year, mm 
the month number, dd the day number, hh the hour and mm the minutes). The 
default prefix string (default Backup_) can be changed. 

• The backup folders older than the value (days) below will be cleaned 
automatically: fill in the number of days the saved backups will be kept (default 
14). 
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• Backup occurs daily at: fill in the time (in hours:minutes:seconds 24-hours 
format) at which backups are to be taken (default 02:00:00). 

 

Adapt the parameters and click Next to continue. The new configuration will be setup, 
click Next in the “Action Window” and click Finish in the “Completing the Server 
Administration Wizard” window. 
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Some remarks on scheduled backups: 

• A backup of the configuration is always taken, the default configuration has a 
daily backup scheduled. 

• It is important to make a backup on another disk than the default location. 
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Redirect the WORKFLOW MANAGER server 
resources 

Each server system that is installed uses by default the locally installed resources (fonts, 
CMS database, DGC curves…). With the Redirect Central Resources task these 
resources can be redirected to a data server system. This redirection can be set up for 
all resources together or individually for each resource. 

When the Redirect Central Resources button is clicked in the  tab sheet of the “ 
Administration” window and after clicking Next in the welcome window, the following 
“Setup the location of the Server software general resources” window will be displayed. 
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If all the resources are to be redirected to another system, click Browse for server. A 
“Browse for Computer” window will be displayed. Select the particular computer to which 
all resources are to be redirected under the entry 

My Network Places\Entire Network\Microsoft Windows Network 

and click OK. Click Next in the “Setup the location of the Server software general 
resources” window to start the redirection process. 

Remark that the Browse for server button will be deactivated as soon as at least one 
resource was redirected to another system. 
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If only some of the resources are to be redirected click the Advanced>> button. A table 
with a list of all the central resources will be displayed together with their location, after 
an initial installation all resources are directed towards the local computer. When the 
Advanced>> button is clicked the Browse for server button is deactivated. This button 
can be re-activated by clicking the Advanced<< button. 

Select the particular resource to redirect and click Browse…. Select the particular 
computer to which the resource is to be redirected under the entry My Network 
Places\Entire Network\Microsoft Windows Network and click OK. 

When all the required redirections are set up click Next in the “Setup the location of the 
Server software general resources” window to start the redirection process. 

The “Connected Clients and Running Tasks” dialog will be displayed as described in the 
first chapter. Wait until all clients logged off or force the clients to log off. A window 
reporting that the configuration is finished will be displayed, click Next to continue. 

 

 

 

The server will be stopped. A window with progress indication and logging information 
for stopping the server will be displayed. At the end click Next. 

The server will be started. A window with progress indication and logging information for 
starting the server will be displayed. At the end click Next. 

Click Finish in the “Completing the Server Administration Wizard” window. 
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Manage RestorePoints 
A Restore Point is a complete set of backup data of a WorkFlow Manager Server 
(configuration and contents of the databases, comprising the current hotfolders, FLEXRIP 
devices configures, tickets, jobs etc…) at a certain moment in time. This information can 
be restored to fall back on the situation at the moment the Restore Point was made. 

To be able to return to a previous configuration of the WorkFlow Manager a number of 
conditions must be fulfilled: 

• A backup of the WorkFlow Manager configuration (config.db on the CFS folder) must 
be present. 

• A backup of the WorkFlow Manager databases must be available. 

• Both backups must be consistent with each other. 
 

The  Server Admin Wizard allows an operator to make backups of both the WorkFlow 
Manager configuration and the databases. It allows a user to specify where the backups will 
be written. 

 

This CHAPTER introduces the concept of Restore Points. A Restore Point consists of a 
backup of the WorkFlow Manager configuration server and a backup of the WorkFlow 
Manager databases at a certain moment in time. 

The Server Admin Wizard allows an operator to create a Restore Point for those WorkFlow 
Manager configurations where the database engine is running on the same server as 
WorkFlow Manager. For more complex configurations the Server Admin Wizard provides the 
tools to create a Restore Point manually. 

This paragraph describes how a Restore Point can be made when both the Esko  server and 
the SQL database engine run on the same computer. This is the case for most of the known 
configurations. 

 

Server Admin Wizard 
A Restore Point can be created using the Server Admin Wizard. In the “ Administration” 
dialog box go to the “” tab and select “Manage RestorePoints”. This will start the Database 
Wizard in restore point mode. The following tasks are available: 

1. Create RestorePoint: to create a new restore point. This function is available when 
the setup of the Restore Point was executed. 

2. Restore from RestorePoint: To return to a previous version of Esko  using a 
Restore Point that was created in the past. 

3. Setup RestorePoint: To specify where the backups created by the Restore Point will 
be written. 

4. Delete RestorePoint: To remove a Restore Point from the server. 
 

Information created 
The folder where the Restore Points will be written is stored in the registry key 
“HKEY_LOCAL_MACHINE\SOFTWARE\Barco Graphics\BGMD\RestorePointFolder”. The 
value of the key is of type REG_SZ. 
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The key is updated with the “Setup RestorePoint” option in the Server Admin Wizard. 

 

A Restore Point entry is a subfolder in the “RestorePointFolder” with the following name 
format “RP_YYYYMMDDHHMM”. Within this folder the following items are created: 

1. config folder: This folder contains the backup of the Esko  configuration. The content 
of the config folder is identical to what is obtained with the “Manage Server software 
Configuration: Backup and Restore” tool. 

2. database folder: This folder contains the backup of the different databases used by 
Esko . 

3. info.dat file: The info.dat file contains general information about the Restore Point. 
This information is shown in the Server Admin Wizard when selecting a Restore 
Point. The information contains: 

• Server: The name of the server on which the restore point is created. 

• Version: The version of the server. 

• Created: When the restore point is made. 

• Build: The build number of the server. 
 

 

Important: The config server backup information created with a Restore Point is not used 
during the upgrade procedure. The upgrade procedure uses the most recent configuration 
taken by the configserver get program (configured with “Manage Server software 
Configuration: Backup and Restore”). 
 

This paragraph describes how a Restore Point can be made when the  server and the  
database engine (SQL server) run on different computers. 

 

Manual creation of a Restore Point 
To be able to create a Restore Point  must be running. Because SQL server is not able to 
make backups on a remote disk, the Restore Point must be created on the server where the 
database engine is running. If an Application Server is used, a backup of the database for the 
Application server must also be made. 

Preparation 
To be able to manually create a Restore Point the following preparatory steps need to be 
performed: 

1. On the server(s) where the database(s) is (are) running create a folder that will be 
used to store the Restore Point data. 

2. Share this folder(s) on the network; make sure that the BGSYSTEM account and the 
administrator account used to run the Server Admin Wizard have access to the 
folder(s). 

3. In this (these) folder(s) create a “config” and “database” subfolder. 

Database backup  
To create the database backup of a Restore Point proceed as follows: 
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1. Make sure that no users are logged on and that no tasks are running on the server. 
This can done by selecting “Stop or Start the Server software” from the Server Admin 
Wizard. In the “Connected Clients and Running Tasks” window wait until all activity 
has terminated. When there is no longer activity on the server click “Cancel” to abort 
the shutdown sequence. 

2. From the Server Admin Wizard go to the “Database” tab and select “Manage 
Databases: Properties, Backup, Restore, Delete, Attach and Fix, Create, Move”. This 
will start the Database Wizard. 

3. From the “Select an Administration Task” select “Backup database” and click Next. 
This will open the “Select the SQL Server” window. 

4. Select the server where the database engine runs and connect to the database. 
When the connection succeeds click Next to start the “Database selection window”. 

5. Select the “FastLane_TM” database. 

6. Enter the folder where the backup file can be stored. Use the Browse button to 
navigate to the database subfolder created in the preparation step. 

7. Check the “Backup now” check box.  

8. Click Next to start the backup. 

9. Click Next to show the Dbase Wizard completion window. 

10. Click Finish to terminate the Dbase Wizard. 

11. Repeat steps 9 through 17 for the “FastLane”, “Jobs”, “BGTHMBBASE” and 
“BGARCHBASE” databases. Make sure the backups are all written in the same 
folder. 

 
Configuration backup 
To set up a Backup of the  configuration: 

1. Start the Server Admin Wizard, select “Manage Server software Configuration: 
Backup and Restore”. This will start the Server Administration Wizard tool. 

2. Click Next. 

3. From the “Select an Administration Task” window check “Configure Server software 
Backup” and click Next. This will open the “Server software Backup Configuration 
Settings” window. 

4. In the destination folder edit field enter the UNC name of the config share created in 
the preparation step. (Example: \\mordor\MyRestorePoint\config) and click Next. 

5. Click Next to show the termination window and Finish to terminate the wizard. 
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To create a Backup of the WORKFLOW MANAGER 
configuration: 
 

1. Start the Server Admin Wizard, select “Manage Server software Configuration: 
Backup and Restore”. This will start the Server Administration Wizard tool. 

2. Click Next. 

3. From the “Select an Administration Task” window check “Backup Server software 
configuration” and click Next. This will start the backup of the configuration. The 
backup will be written on the folder that was previously configured. When the action 
terminates click Next. This shows the list of the most recent configuration backups. 

4. Click Next to show the termination window and Finish to terminate the wizard. 
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Set system password 
The ESKO  server service and the Application Server service (if installed) both run under 
the same account BGSYSTEM with default password Drupa2000. If the password for 
this account is to be changed, both services must be reconfigured. The Set system 
password performs this task. 

1. Log in as Administrator. 

2. Click Start in the bottom task bar, select Programs, Esko,  7.0 and click Server 
Admin. 

3. The “ Administration” window will be displayed. Select the Servers tab. 

 

 
149.tif 



 

 Page 197 of 210 

4. Click the Manage Servers: Set System Password button, a “Select an 
Administration Task” with the (only) task Set Password… will be displayed, click 
Next 

 
150.tif 

 

5. A “Enter the new password for the BGSystem account and confirm” window will be 
displayed. Fill in the New password and Confirm new fields and click Next. 
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6. The “Connected Clients and Running Tasks” dialog will be displayed as described in 
the first chapter. Wait until all clients logged off or force the clients to log off. 
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7. At the end of the password setting operation, click Finish in the “Action Window”. 

8. The WorkFlow Manager server will be stopped. A window with progress indication 
and logging information for stopping the WorkFlow Manager server will be displayed. 
At the end click Next. 

9. The WorkFlow Managerserver will be started. A window with progress indication and 
logging information for starting the WorkFlow Managerserver will be displayed. At 
the end click Next. 

10. Click Finish in the “Completing the Server Administration Wizard” window. 
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Appendix 
 

Appendix 1: HP Indigo Labels and Packaging 
Color Kit powered by EskoArtwork 

 
A short description of how to create a Color Strategy for the HP Indigo 
Press 

 
Please check the HP Indigo Labels and Packaging Color Kit powered by 
EskoArtwork documentation for a full explanation. 

 

 

Start HP Indigo Labels and Packaging Color Kit powered by EskoArtwork. 

Select the Color Strategies icon, then select New from the File menu. 
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 The following dialog appears: 

 

 

46.tif 

 

Expand this dialog by clicking the envelope button in the bottom right corner. 
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Source and destination profile 
 

The source profile is selected from the Source Profile dropdown list and the 
destination profile from the Destination Profile. 

 

The source profile will normally be a four‐color profile like, e.g. crom‐offs, which is 
a preinstalled profile for Cromalin offset. Of course you can create your own CMYK 
profile of the press, using HP Indigo Labels and Packaging Color Kit powered by 
EskoArtwork. 
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48.tif 

 

The destination profile describes the press and substrate on which is printed. When printing in 
CMYK this is a four‐color profile, when printing in Indichrome it is a six‐color profile. One 
preinstalled profile is delivered with the software: hp_indichrome.icc. 
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49.tif 

 

If you do not want to color convert CMYK colors you have to take source and destination 
profile equal. E.g. both crom_offs for a CMYK press or both hp_indichrome.icc for an 
Indichrome press. Selecting <automatic> for Destination Profile has the same effect. 

 

PANTONE conversion 
 

There are 2 ways to color convert PANTONE inks. The first one uses a PANTONE table that 
contains the CMYK/CMYKOV equivalents for each PANTONE ink. The second one uses the 
selected output profile. 

 

1. Doubleclick ‘Convert Special Inks...’ 
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The PANTONE Inks option selects one of the two. The value Use Destination Profile 
corresponds to the output profile as shown below. 
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The other values correspond to a table.  

Which entries are listed depends on the type of output profile: a CMYK profile or an 
Indichrome profile.  

In case of an Indichrome output profile the entries are HP Indichrome and PANTONE 
Hexachrome. The first selects the HP Indigo table containing the Indichrome equivalents, the 
latter can be ignored. 

 

 

52.tif 

 

In case of a CMYK output profile the entries are PANTONE CMYK swop and PANTONE 
CMYK Euro as shown below. 
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PANTONE exceptions 
 

No matter what type of conversion you select for PANTONE inks, you can always define 
exceptions for specific PANTONE inks. You can force the CMYK/CMYKOV values used for 
specific PANTONE inks. 

 

In the dialog for a color strategy double click Convert Special Inks. 

A new dialog pops up: 

 

Double clicking the white square on the left opens another dialog, which allows you to select 
inks defined in HP Indigo Labels and Packaging Color Kit powered by EskoArtwork.  
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• Open the PANTONE book, select the ink you want and drag it to the white square.  
• In the column Use select “Use Custom Values”.  
• Now for each process color you can enter a value between 0% and 100%.  

This value will be used for conversion. 
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Note that the same is possible for designer inks. 
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Extra output inks 
 

The HP Indigo Press allows printing with additional inks, apart from the basic 
CMYK/CMYKOV inks. Whenever a job contains these extra inks, they must not be converted 
to CMYK/CMYKOV, but mapped straight to the corresponding ink on the press. You can 
define this in the Color Strategy. 

 

In the dialog of a Color Strategy double click Extra Output Inks. 

A new dialog pops up: 

 

 

58.tif 

 

Double clicking the white square on the left opens another dialog, which allows you to select 
inks defined in HP Indigo Labels and Packaging Color Kit powered by EskoArtwork. 
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Open the PANTONE book, select  the ink you want and drag it to the white square. 
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Importing ICC profiles 
 

When importing an ICC profile you have to assign inks to the corresponding channels. In 
case of CMYK profiles you have to select process CMYK inks. In case of Indichrome this is 
process CMYK, designer “IndiChr Orange” and designer “IndiChr Violet”. This can also be 
done by drag and drop. 

 

Installation of the color database 
 

When first installing the color database you have to define the Indichrome Orange and Violet 
inks as designer inks. You do this by opening both the designer ink book and the Indichrome 
ink book in HP Indigo Labels and Packaging Color Kit powered by EskoArtwork, and drag & 
drop the inks “IndiChr Orange” and “IndiChr Violet” from the Indichrome book to the designer 
book. 
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